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1 Introduction

1 Introduction

The ImageQuant LAS 4000

The ImageQuant LAS 4000 is a camera system for producing digital images of gel or membrane samples
or films. It is used together with the ImageQuant LAS 4000 Control Software to:

* Expose chemiluminescent samples or membranes.

* Expose fluorescent samples using epi (incident) or trans (transmitted) light sources, for example
gels stained by ethidium bromide (EtBr).

The ImageQuant LAS 4000 can be supplied with NIR, Red, Green, Blue and UV epi lights.
* Expose dye-stained gels and membranes or films using epi or trans illumination.

e Expose a sample repeatedly, incrementally or by programming exposure schemes.

Purpose of this manuadl

The ImageQuant LAS 4000 User Manual provides detailed instructions on using the ImageQuant LAS
4000 and outlines the functions of the ImageQuant LAS 4000 Control Software.

Note: Be sure to refer also to the manual Getting Started with ImageQuant LAS 4000 for
regulatory information, specifications and the troubleshooting guide.

1.1 Important user information

Read this before using the ImageQuant LAS 4000

]3]

All users must read the safety instructions in Getting started with ImageQuant LAS 4000 before installing,
using or maintaining the equipment.

Do not operate the ImageQuant LAS 4000 in any other way than described in the user documentation.
Otherwise, you may be exposed to hazards that can lead to personal injury and you may cause damage
to the equipment.

ImageQuant LAS 4000 User Manual 28-9607-42 AB 5



1 Introduction
1.1 Important user information

Intended use

The ImageQuant LAS 4000 is a camera system that produces digital images of chemiluminescent,
dyed or fluorescent gels and membranes. The ImageQuant LAS 4000 is intended for research use only,
and shall not be used in any clinical procedures, or for diagnostic purposes.

Safety notices

The user documentation contains WARNINGS, CAUTIONS and NOTICES concerning the safe use of the
product. See definitions below.

Warnings

WARNING

WARNING indicates a hazardous situation which, if not avoided, could result in death
or serious injury. It is important not to proceed until all stated conditions are met
and clearly understood.

Cautions

CAUTION

CAUTION indicates a hazardous situation which, if not avoided, could result in minor
or moderate injury. It is important not to proceed until all stated conditions are met
and clearly understood.

Notices

NOTICE
e NOTICE indicates instructions that must be followed to avoid damage to the product
or other equipment.

Regulations and standards - supplementary
information

This equipment conforms to the regulations and standards described below.
EMC VCCI Class A Conformance

FCC Part 15B Class A

ICES-003 Class A

IEC 61326-1: 2005

EN 61326-1: 2006
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1 Introduction
1.1 Important user information

Safety  UL61010-1: second edition
CAN/CSA-C22.2 No. 61010-1, second edition
[EC61010-1: 2001, second edition
IEC61010-2-081, first edition
EN 61010-1: 2001
EN 61010-2-081: 2002

Laser  USA 21 CFR, Chapter |, Subchapter J, Part 1040.10 Laser Products
IEC 60825-1: 2001
EN 60825-1: 1994+A11: 1996+A2: 2001

CE LV Directive 2006/95/EC (as amended)
EMC Directive 2004/108/EC (as amended)
Machinery Directive 2006/42/EC

Note: This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in
a commercial environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instruction manual,
may cause harmful interference to radio communications. Operation of this equipment
in a residential area is likely to cause harmful interference in which case the user will be
required to correct the interference at his own expense.

This Class A digital apparatus complies with Canadian ICES-003. Cet appareil numérique
de la classe A conforme a la norme NMB-003 du Canada.

Note: This is a class A product. In a domestic environment this product may cause radio
interference in which case the user may be required to take adequate measures.

Information for traceability

Manufacturer: GE Healthcare
Contact information: See back cover
Power cable

1 InJapan and North America:
Do not use cables other than the power cable that comes with the equipment.
2 In EU countries:

The cable is given the following CEE Certification Number.

VDE 6522-1570-8035/AIG DEMKO 116773 ASC
SEMKO 9449029 KEMA 93.6830.04-KCS/LB
NEMKO P94102620 CEBEC 8652

El (FIMKO) 179615-02 OVE 0204-515-00
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1 Introduction
1.1 Important user information

Mercury-containing products label

CAUTION
A E Ultraviolet ray lamps in this product contain mercury, which must be
|

recycled or disposed of in accordance with local, state, or federal laws.

LED safety
This product is categorized as a class 1 laser (LED) device (IEC60825-1+A2:2001).

LED light sources

Red Epi light Wavelength 630nm Class 1
Green Epilight  Wavelength 520nm Class 1
Blue Epi light Wavelength 460nm Class 1

RGB module Wavelength 630,

520 and 460nm Class 1
UV Epi light Wavelength 365nm Class 1M
NIR Epi light Wavelength 710nm Class 1

White Epilight ~ Wavelength 470-740nm  Class 1

CAUTION
Do not look at the light directly through optical instruments.

CAUTION
If the door is opened and the interlock is cancelled, class 1 laser (LED) will be emitted.

CAUTION

Use of controls or adjustments or performance of procedures other than those
specified in the user documentation may result in hazardous radiation exposure.

> B B

Notes and tips

Note: A Note is used to indicate information that is important for trouble-free and optimal use
of the product.
TIP: A tip contains useful information that can improve or optimize your procedures.
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1 Introduction
1.1 Important user information

Typographical conventions

Software items are identified in the text by bold italic text. A colon separates menu levels, thus File:Open
refers to the Open command in the File menu. Hardware items are identified in the text by bold text
(e.g., Power switch).
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2 The ImageQuant LAS 4000

2 The ImageQuant LAS 4000

This chapter describes the features and part names of the ImageQuant LAS 4000 hardware, and the
connectors that connect the various parts of the equipment.

2.1 The ImageQuant LAS 4000 exterior

d [+

] e
I— 4
— 5
] \:@
| — | —
7 6
Part Name Description
1 Camera head CCD cooling and image data output
2 Indicator panel Status lights
3 Power LED Lights when the power is on
4 Busy LED Lights when an exposure is in progress
5 Error LED Lights when an error is detected
6 Power switch
| Power ON
O Power OFF
7 Intelligent dark box (IDX) = Dark box
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2 The ImageQuant LAS 4000
2.2 Inside the ImageQuant LAS 4000

2.2 Inside the ImageQuant LAS 4000

Part ‘ Name Description
1 Epi light connector Connects the epi light to the IDX

2 Epi light source NIR Epi light (710 nm)

Red Epi light (630 nm)

Green Epi light (520 nm)

Blue Epi light (460 nm)

RGB Module (Epi light with red, green and blue LEDs)
UV Epi light (365 nm)

White Epi light
3 Sample tray Supports the sample
4 Lifting table Moves the sample to the selected tray position
5 Lens F0.85/43 mm LAS High Sens. lens, or

F1.8/24 mm wide view lens

6 Lens connector Connects lens to IDX

ImageQuant LAS 4000 User Manual 28-9607-42 AB 11



2 The ImageQuant LAS 4000
2.2 Inside the ImageQuant LAS 4000

Part

7

Name

Automatic filter changer

Description

Used to hold filters selected in the control software. The follow-
ing filters are commonly used:

IR785 Alexa (filter for NIR LED)

R670 Cys (filter for red LED)

575DF20 Cy3 (filter for green LED)

605DF40 EtBr (filter for detecting EtBr)

510DF10 (filter for detecting GFP)

Y515 (filter for blue LED)

L41 UV (filter for UV LED)

Trans light source connec-
tor

Connects the UV transilluminator or White light table to IDX

Trans light source

312 nm UV transilluminator
White light table

Note:
Note:
Note:

Do not use connectors other than those supplied for the Epi light sources.

Do not connect cables other than those supplied to the lens.

Do not connect anything other than the transmitted light sources to the transmitted light

source connector.

2.3 Connections

Camera head

Camera cable

USB cable

Note:

12

Do not connect cables other than the camera cable supplied with the equipment.
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2 The ImageQuant LAS 4000

2.3 Connections

Note: Do not disconnect the camera cable other than when removing the camera head.
LAS High Sens. lens

High Sens. lens cable

A cable used for connecting the LAS High Sens. lens and the IDX.
Make sure that the cable is securely connected.

Note: * Never remove the cable except when replacing the lens.

e Be sure to turn off the equipment before replacing the lens.
Epi lights

Connector on Epi light source

The Epi light sources illuminate the object to be imaged from the
upper right and upper left.

The connector is connected to the Epi light source connector inside

) _ . the IDX.
Figure 2.1: Incident (Epi) light source
connector (rear)

Epi light source connector

A connector used for connecting the Epi light source. Power is
supplied to the Epi light source through this connector.

Figure 2.2: Inside the instrument

Note: e The Epilight sources for the right and left sides are different. Attach the appropriate
source on respective sides.

e The connector will be connected when the Epi light source is inserted. Make sure
that the connector is securely connected. See Section 3.3.2 Changing the Epi lights,
on page 29.

e Be sure to use Epi light sources of the same type for the right and left sides other-
wise an incorrect image will be obtained.

e Do not insert any connector other than those for the Epi light sources.

ImageQuant LAS 4000 User Manual 28-9607-42 AB 13



2 The ImageQuant LAS 4000
2.3 Connections

USB cable

USB cable
m Connects ImageQuant LAS 4000
and the analysis PC. Read data will
be sent from ImageQuant LAS 4000
: to the analysis PC through the USB
ID cable. USB 2.0 is supported.

Connect one end with the Image-
Quant LAS 4000 camera head USB

@ connector, and the other to a USB
Analysis PC ImageQuant LAS 4000 port Of the GnGlySiS PC
Note: e Use the USB cable supplied with the equipment.

e Do not connect the instrument and the PC via a USB hub.

¢ Do not connect USB equipment other than ImageQuant LAS 4000 to the PC. Simi-
larly, do not use other USB equipment connected to the PC while ImageQuant LAS
4000 is in use. This may result in the loss of image data.

e The PC must be certified according to UL60950-1 (UL listed) and IEC60950-1.

2.4 Parts and accessories

Epi tray F0.85 43mm LAS high sensitivity lens

14 ImageQuant LAS 4000 User Manual 28-9607-42 AB



2 The ImageQuant LAS 4000

2.4 Parts and accessories

M 9 .

Cal plate GR (Pink) Cal plate DI
Cal plate FL (Green)

White trans tray UV trans tray
(7 —N
/7 —
Iy N
(( —

(2 ™

\
\

N y,

Gel sheet

White light table
UV transilluminator

F1.8 24mm wide view lens F-mount adapter

ImageQuant LAS 4000 User Manual 28-9607-42 AB 15



2 The ImageQuant LAS 4000
2.4 Parts and accessories

Green Epi light (520 nm), set of two
Red Epi light (630nm), set of two

=

RGB module, Epi lights, set of two

UV Epi light (365 nm), set of two NIR Epi light (710 nm), set of two

Filters:

Y515 filter (Y515)
GFP detection filter (510DF10/GFP)
EtBr detection filter (605DF40/EtBr)

Cy3 detection filter (575DF20/Cy3)
Cy5 detection filter (R670BP/Cy5)
Alexa Fluor 750 detection filter (IR785/Alexa)

Ultraviolet protection filter (L41/UV)

Note: * The combined accessories and light source vary depending on the system that you
purchase.

* Make sure to retain the caps and filter cases.
» Store the incident (Epi) light sources in a container box.

e The UV trans tray will degrade after many UV illuminations. It can be used up to
approximately 1000 times if each exposure time is 1 second. New trays can be
purchased separately.

16 ImageQuant LAS 4000 User Manual 28-9607-42 AB



3 Exchanging accessory parts

3 Exchanging accessory parts

3.1 Changing or installing a filter

Opticalfilters are installed in the filter turret localted under the lens inside the IDX. This section describes
how to install or change a filter on the filter turret.

Install a filter in the filter turrent and register it in the ImageQuant LAS 4000 Control Software as follows:

i ImageQuant LAS 4000
File Edit Wew Option Help

Imogeouoﬁ\r 3
LAS 4000

Change filter and fiter posttion

Current Filters Select Filers

1: Thraugh Through

2: Through Through

3: Through Throug

4: Thraugh Through

Rl E
I EE

5
4|y

5: Through Through

[ o J[ rrerdom [ conce |
l

pp—

1 Ensure that the camera head and PC are connected. Turn on the instrument and the PC, and start
the ImageQuant LAS 4000 Control Software.

2 Close the instrument door

ImageQuant LAS 4000 User Manual 28-9607-42 AB 17



3 Exchanging accessory parts
3.1 Changing or installing a filter

3 Select Filter Customization in the Option menu in the ImageQuant LAS 4000 Control Software
main window.

4 Click the Filter down button.

The filter changer is lowered.

5 Open the instrument door.

6 Turn the filter changer so the desired position is easily accessible. If a filter is already in place at
this position, unscrew it carefully and put it back in its cover.

7 Screw the new filter into place.

8 Select the appropriate filter from the drop-down list and click the OK button.

Filter Customization

Current Filkers

1 Through
2! Through
3: Through
4: Through

5: Through

Change Filter and filker position

Select Filters

Thi v Through

l:Thl 605DF40
Y515 Di
Thi  s100F10
|:Th| R785
RE70
575DF20

[ QK

J [ Fiter down ]r L1

Note:

The filter changer returns to the original position when you click the Start, Focusing or
Method/Tray position buttons.

3.2 Installing or exchanging the lens

Two lenses can be used with the ImageQuant LAS 4000, an F0.85 43mm LAS High Sens. lens, and an
optional F1.8 24mm wide view lens. The wide view lens can image samples up to 250 x 250 mm in size.
For all other applications, the LAS High Sens. lens is recommended. This section describes how to install
or exchange the lenses.

18
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3 Exchanging accessory parts
3.2 Installing or exchanging the lens
3.2.1 Removing the LAS High Sens. lens

F0.85 43mm LAS High Sens. lens | F1.8 24mm wide view lens

3.2.1 Removing the LAS High Sens. lens

1 Close the instrument door. If the power is turned off and the filter changer is down, proceed to step
4.

2 Select Option:Lens Exchange.

Option
CCD Calibration, ..
FlatFrame Calibration, .
FlatFrame Calibration Pro...

Filker Customization. ..
Lens Exchange. ..
Method Setting...

A message is displayed.

Lens Exchange

Close the door and click O,

Imageciuant LAS 4000 control software will shuk down, Do you wank to continue?

3 Click OK.

4 Lens Exchange

Switch off ImageQuant LAS 4000 instrument and change the lens.,

Turn off the instrument using the power switch.

ImageQuant LAS 4000 User Manual 28-9607-42 AB 19



3 Exchanging accessory parts
3.2 Installing or exchanging the lens
3.2.1 Removing the LAS High Sens. lens

5 Loosen and remove the lens hood, then place the lens cap over the lens.

a —
Lens hood
Lens cap C/C)

6 Disconnect the lens cable connector by rotating the knurling ring.

— J
Q - Knurling ring
—r

, N Connector of the lens cable
7 »
A1 T

7 Turn the lens slightly to the left and loosen it while pushing the lens release lever.

20 ImageQuant LAS 4000 User Manual 28-9607-42 AB



3 Exchanging accessory parts
3.2 Installing or exchanging the lens
3.2.1 Removing the LAS High Sens. lens

8 Rotate the lens to the left by 45 degrees.
The lens comes off downward.

Note: Hold the lens with both hands so as to prevent the lens guide from being damaged.

9 Take out the lens slowly along the lens guide toward you.

10 Place the end cap on.
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3 Exchanging accessory parts
3.2 Installing or exchanging the lens
3.2.1 Removing the LAS High Sens. lens

Note: * Be sure to put the high-sensitivity lens sideways and lower it gently when placing it
on the desk. Placing the lens downward may affect the mechanical precision of the
lens barrel.

* Make sure that the filter changer has come down far enough to make room for
replacing the lens.

* Do not let the high-sensitivity lens hang on the lens guide. The lens may fall causing
injury or damage.

* The high sensitivity lens weighs 4.5 kg. Be careful when handling it.

3.2.2 Installing the LAS High Sens. lens

1 Close the instrument door.If the power is turned off and the filter changer is down, proceed to step
4.

2 Select Option:Lens Exchange....

Opkion
CCD Calibration. ..
FlatFrame Calibration..
FlatFrame Calibration Pra,..

Filker Customization...
Lens Exchange...
Method Setting. ..

A message is displayed.

Lens Exchange

Close the door and click OK,

ImageQuant LAS 4000 control software will shuk down. Do you want bo continue?

Click OK.

3 Lens Exchange

Switch off ImageQuant LAS 4000 instrument and change the lens.,

Turn off the instrument using the power switch.
4 Remove the end cap from the lens.

5 Insert the lens along the lens guide with the red points facing towards you.

22 ImageQuant LAS 4000 User Manual 28-9607-42 AB



3 Exchanging accessory parts
3.2 Installing or exchanging the lens
3.2.2 Installing the LAS High Sens. lens

7 Connect the lens cable.

Turn the knurling ring until it is securely fixed.

\QJ\\/ Knurling ring
@

, P Connector of the lens cable
N
Al ™\

Note: Be sure to connect the lens cable. Otherwise, the high sensitivity lens cannot be
recognized. This may cause malfunction of the equipment.
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3 Exchanging accessory parts
3.2 Installing or exchanging the lens
3.2.2 Installing the LAS High Sens. lens

24

8 Remove the lens cap.

Lens cap

9 Install the lens hood.

3
Lens hood — i %\\
/

3.2.3 Removing the wide view lens

1 Close the instrument door. If the power is turned off and the filter changer is down, proceed to step

4.

2 Select Option:Lens Exchange....

opkion
CCD Calibration, .
FlatFrame Calibration..
FlatFrame Calibration Pro...

Filker Customization...
Lens Exchange...
Method Setting. ..
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3 Exchanging accessory parts
3.2 Installing or exchanging the lens
3.2.3 Removing the wide view lens

A message is displayed.

Lens Exchange
Close the door and click O,

Imageciuant LAS 4000 control software will shuk down, Do you wank to continue?

Click OK.

3

Switch off ImageQuant LAS 4000 instrument and change the lens.,

Turn off the instrument using the power switch.

4 Remove the F-mount adapter and lens while pushing the release button provided on the lens.

Remove the wide view lens together with the F-mount adapter by rotating it.
Remove the lens hood from the lens.

Place the lens cap on.

o N O O,

Place the end cap on the lens and the cap on the F-mount adapter.

3.2.4 Installing the wide view lens

1 Close the instrument door. If the power is turned off and the filter changer is down, proceed to step
4.

2 Select Option:Lens Exchange....

Option
CCD Calibration, ..
FlakFrame Calibration, .,
FlatFrame Calibration Pro...

Filker Customization. ..
Lens Exchange. ..
Method Setting...
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3 Exchanging accessory parts
3.2 Installing or exchanging the lens
3.2.4 Installing the wide view lens

A message is displayed.

Lens Exchange

Close the door and click OK,

ImageQuant LAS 4000 cantrol saftware will shut down. Do you want ko continue?

Click OK.

3 Lens Exchange

Switch off ImageQuant LAS 4000 instrument and change the lens.,

Turn off the instrument using the power switch.

4 Remove the cap attached to the F-mount adapter by turning it to the right.

F-mount adapter

5 Remove the end cap from the wide view lens.

6 Alignthe White point mark of the F-mount adapter with the lens mark and turn to lock them together.
Hold the lens so that the red point is towards you.

F-mount adapter

Wide view lens
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3 Exchanging accessory parts
3.2 Installing or exchanging the lens
3.2.4 Installing the wide view lens

7 Fix the lens in position be turning it to the right.

8 Remove the lens cap.

9 Placel the lens hood on the lens.

3.3 Changing the light sources

Both trans (transmitted) and epi (incident) light sources are available for exposure with the ImageQuant
LAS 4000. This section describes how to change both types of light source.

The following table summarizes the properties of the various light sources.

Peak wavelength

UV transilluminator 312 nm
Transmitted -
White light table -
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3 Exchanging accessory parts
3.3 Changing the light sources
3.3.1 Changing the UV transilluminator or white light table

Peak wavelength

UV Epi light 365 nm
Blue Epi light 460 nm
Green Epi light 520 nm
Red Epi light 630 nm
Incident RGB module (3-color Epilight) | 460nm or
520nm or
630 nm
NIR Epi light 710 nm
White Epi light -

3.3.1 Changing the UV transilluminator or white light table
The UV transilluminator and white light table are exchanged as follows:

1 If neither the UV transilluminator or white light table are currently in place inside the instrument,
proceed to step 4.

2 Turn the lever holding the light source to unlock it.

/

\ﬂﬁ‘ r‘ {
2y == \\] ,

]

(‘T'S_J I

=

3 Pull out the light source carefully along the guide while holding it with both hands.

PEE— e BN
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3 Exchanging accessory parts
3.3 Changing the light sources
3.3.1 Changing the UV transilluminator or white light table

4 Push the desired light source in along the guide at the bottom of the IDX.

5 Turn the lever at the front to lock the light source into position.

‘/\ﬂﬁ‘ r‘ [\
1 == \\ o
\ |
'y //

\ —’

3.3.2 Changing the Epi lights

This section describes how to change a set of Epi lights. The RGB module Epi lights are also installed
as described here.

Note: The tray should be at tray position 4 before installing Epi lights. If the tray is higher, then
it should be lowered to tray position 4 using the ImageQuant LAS 4000 Control Software
before attaching the lights, as described below.

Latch

Epi light base

1 Ifthetrayis at Tray position 4, proceed to step 3. Otherwise, close the IDX door.
2 Click on Method/Tray position, set Tray position to 4, and click the OK button.

3 Open the IDX door. If no Epi light is currently in place inside the instrument, proceed to step 7.
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3 Exchanging accessory parts
3.3 Changing the light sources
3.3.2 Changing the Epi lights

4 Spring up the latch to unlock the Epi light.

7 Before installing the new Epi light, ensure that the latch is sprung open (upwards).
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3 Exchanging accessory parts
3.3 Changing the light sources
3.3.2 Changing the Epi lights

8 Hook the hanger located on top of the Epi light to the top edge of the Epi light base.

2
No. Action
1 Two guide holes are located on the back of the Epi light base.
2 Slide the hook after attaching the guide pins to the guide holes.

9 Push the Epi light while holding the latch open, and slide it inwards until a click sound is heard.

11 Repeat this process for the opposite side.

Note: * The Epi lights are clearly labelled L for the left and R for the right sides.

* Install the Epi lights in matching pairs only. If Epi lights with different wavelengths
are used, the intended image will not be obtained.
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4 Operating the ImageQuant LAS 4000

4 Operating the ImageQuant LAS 4000

This chapter describes the ImageQuant LAS 4000 Control Software and how to expose gels, membranes
or films to obtain digital images.

4.1 Layout of the ImageQuant LAS 4000 Control Software

The exposure of samples in the ImageQuant LAS 4000, the setting of exposure conditions and the
viewing of the digitized images are performed within the ImageQuant LAS 4000 Control Software.

The following illustration shows the features of the main window of the ImageQuant LAS 4000 Control
Software.

# Imageduant LAS 4000

Description

1 Menu bar 6 The setting state such as the temperature
condition of CCD is displayed.

2 Exposure Type 7 The state of the Intelligent dark box (IDX) is
Sets the exposure method displayed.

3 Exposure Time 8 Method/Tray position
Sets the exposure time. Sets the detection method and tray position.
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4 Operating the ImageQuant LAS 4000
4.1 Layout of the ImageQuant LAS 4000 Control Software

Description ; Description
4 Sensitivity/Resolution 9 Focusing

Sensitivity can be set. Adjusts the focus and position.
5 Add Digitization Image 10 Start

Adigitization image is exposed simultaneous- Starts the exposure.

ly with a chemiluminescence image.

(Chemiluminescence method only.)

Note: The software needs to be started once after installing from an account with administrator
priveleges. This is to ensure that necessary folders and files are created.

4.2 Preparation for exposure

{1

o ]
 I—  I—
1
Analyzing PC
Step Operation
1 Turn on the ImageQuant LAS 4000, computer and peripheral equipment.
Start up ImageQuant LAS 4000 Control Software. Imogetuant LAS 400D
ImageQuant LAS 4000 is in self-diagnosis.
A message is displayed until the ImageQuant LAS 4000 is ready. Please sk
2 NANNNNE
Note: The power switches of the instrument and PC can be turned on in any order.
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4 Operating the ImageQuant LAS 4000
4.2 Preparation for exposure

Step Operation

Wait until the CCD has reached the preset cooling temperature and is ready for use.

 jmagetuant LAS 1000
Fie E@ Vew Oplon  Help

ImageQuant

Exposure Type
——

Exposure Time
3 Ak

) Manssl

Sensitivity / Resolution
Svelerd v

Add Digitization imaga

Flat frame
Pk

TIP: * Theinstrument will be ready in a few minutes. The power LED on the instrument is
lit blue when the instrument is ready.

Method(Tray position

* Method/Tray position and Focusing can be prepared even if the CCD has not cooled
completely.

* The Start button can be clicked even when the CCD is not completely cooled with
the EtBr trans method.

4.3 Calibration

Ensure that the ImageQuant LAS 4000 is properly calibrated. See Section 5.12.1 CCD Calibration, on
page 104 and Section 5.12.2 Flat Frame Calibration, on page 105.

4.4 Placing the sample

This section describes how to choose an appropriate sample tray, and how to place the sample for
exposure.

1 Select a sample tray suitable for the type of exposure to be performed.

Detection Sample type

Chemiluminescence | Membrane Epi tray

Bioluminescence Titer plate NP tray
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4 Operating the ImageQuant LAS 4000

Detection Sample type Tray
Fluorescence Gel (UV Trans illumination) | UV trans tray
Gel (Epi illumination) Epi tray
Membrane Epi tray
Digitization Membrane Epi tray
Gel (Coomassie, silver stain) | White trans tray

2 Place a sample on the sample tray.

For Epi tray

a Place the sample directly on the tray.

For UV or White Trans trays

a Cutout a gel sheet slightly larger than the sample size.

b Place the gel sheet on the Trans tray.

Gel sheet

c Place the sample on the gel sheet.

Sample

Gel sheet

4.4 Placing the sample

Note: The gel sheet can be used repeatedly. After use, wash it with mild detergent, rinse
with water then dry well. A gel sheet can be reused about 20 times.
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4 Operating the ImageQuant LAS 4000
4.4 Placing the sample

3 Choose the exposure size and tray position
For Epi and Trans trays

e Thereadable area varies depending on the tray position. Place the sample in position according
to its size.

250mm X 250mm

210mm X 140mm

180mm X 120mm

i y 144mm X 96mm

105mm X 70mm
I Position 2 !
I Position 3 I
I Position 4 !
| ]

Maximum capture size when a wide view lens is used
TIP: On the Epi tray, there are round dents marked on the tray for positioning the

sample. Line up the sample using the appropriate dents.
For NP tray

e The NP tray is to be used at tray position 3.

Note: The readable area will be slightly smaller using the F1.8 wide view lens.
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4 Operating the ImageQuant LAS 4000
4.4 Placing the sample

4 Open the IDX door and insert the tray. Place the Epi or Trans trays in position with the side with a
hole facing outwards.

5 Ensure the lens cap is removed and close the IDX door.

4.5 Exposing chemiluminescent samples

This section describes how to take images of chemiluminescent samples. No illumination is used for
this application.

Place a sample on the Epi tray. Put the tray in the ImageQuant LAS 4000 then close the door.

% ImageQuant LAS 4000

L I T —
Exposure Time
4y ——1 Ohuto
@ Manual
Sensitivity / Resolution
S—T

Add Digitization image
Con

Flat frame
|auto
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4 Operating the ImageQuant LAS 4000
4.5 Exposing chemiluminescent samples

Step ‘ Action

Click the Method/Tray position button.
Result: The Method/Tray position dialog opens.

®1
(@ 2
Q3 MR
O 4

!

| IR—

Method / Tray position
o Light Filter s
(%) Chemiluminescence Mone Through FO.85
() Fluorescence
[ [cy2] ¥| [ Elue Y515 Di Fi.85
() Digitization
(%) Epi-ilumination “white (Epi-illumination) Through F2.&
Trans-illumination swhite (Trans-illumination) Through F2.8

1056 x 70 mm

[]

- 0K

‘ [ Cancel ]

e Select Chemiluminescence for Method.
e Select Tray position according to the sample.
e Click the OK button.
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4 Operating the ImageQuant LAS 4000

4.5 Exposing chemiluminescent samples

Step Action

Click the Focusing button.

Result: The focusing controls appear.

£ ImageQusant LAS 4000
Fle ER Yew Oplun Heb
ImageQuant’

LAS 4000

Exposure Type
'ﬂmura Time
At

o b
E |

Sensitivity / Resalution

2
Flat frame
] rightness  [R) 0 @ Adjust
— suos
Check that the sample is correctly postioned and focus the image.
Click the Return button.
TIP: Click on the image to magnify it. Click on the image again to return to the original
size.
Select Precision for Exposure Type.
Exposure Type
3 Pl v Precision
ExposureT ~ Mnerement
O futo Repetition
@ Many_ Program
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4 Operating the ImageQuant LAS 4000
4.5 Exposing chemiluminescent samples

Step ‘ Action

Select Auto or Manual for Exposure Time.

Auto Manual
. Select an exposure time from the drop-down list or enter
posure Type
the exposure time manually. The exposure time can be
P set from 0.01 seconds up to 30 hours.
O Manual
Exposure Type
.
Note: Automatic exposure S
time setting may & e
4 not be possible de- - i
. ensitivity
pending on the L =™
Add Digitiz) %"
sample type and Do 2
method. bl

Chemilumines: 1min

Flat frame

Auto
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4 Operating the ImageQuant LAS 4000

4.5 Exposing chemiluminescent samples

Step Action ‘

Select Sensitivity/Resolution.

Sensitivity / Resolution
High Resolution

Add Di
¢

High
Super

Ultra

High Binning
Super Binning

Note: The check box for Add Digitization Image can be checked to also perform a white-
light exposure, for example to image dye-stained molecular weight markers. In
this case the white epi light should be in place. Leave unchecked if this is not nec-
essary.

5 TIP: Select Help:Sensitivity/Resolution.... This opens the following diagram that de-
scribes the relation between sensitivity and resolution.

Click the Start button.
Result: The exposure is started. The orange Busy LED lights on the instrument during exposure.

rmageloant LAS 4000

File

)
ImageQuant

Exposure Type

Exposure Time
ki
Marussl
0 ==
Sensitivity / Resolution

=

Flat frame
Autn

Expusure Teoe ;  Amec
Finishing Tiee = AM 09240

Exposing...

LTI
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4 Operating the ImageQuant LAS 4000
4.5 Exposing chemiluminescent samples

Step ‘ Action

Adjust the gradations of the exposed image, then save and print the image.

£ Imageluant LAS 4000

Fie Ed Vew Oplon Help
ImageQuant™

LAS 4000

Exposure Type

'E'xposure Time
e

Mand

Sensitivity { Resolution | P- -

=
gl Save

Complete

Click the Complete button.
Result: The display returns to the main screen.

4.6 Exposing fluorescent samples (EtBr)

This section describes how to expose ethidium bromide (EtBr) stained samples using the UV
transilluminator (312 nm).

Place a gel sheet, which has been cut out to be slightly larger than the sample, onto the UV trans tray.
Place the sample on the gel sheet. Put the tray into the ImageQuant LAS 4000 and close the door.

Note: The 605DF40 filter is normally used. If this filter is currently not in the filter turret, it should
be installed. Refer to Section 3.1 Changing or installing a filter, on page 17.

Note: Ensure that the UV transilluminator is installed. For instructions on changing the trans
light source, see Section 3.3.1 Changing the UV transilluminator or white light table, on
page 28.
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4 Operating the ImageQuant LAS 4000

4.6 Exposing fluorescent samples (EtBr)

& ImageQuant LAS 4000 (916 ]
Fle Edt View Option Heb

Exposurs Type
3 —t Prmnicr »|
Exposure Time
4 ——F Oam
5) Marisd

|

Semitivity / Resolution

READY

E *C

Step Action

Click the Method/Tray position button.
Result: The Method/Tray position dialog opens.
| |

Method / Tray position
Method : Light
O Chemiluminescence Mone Through F0.85

(=) Fluorescence

[ [EtEr] v] [ ¥ (Trans-ilumination) | &05DF40 F2.8

() Digitization
(&) Epi-illumination Wwhite {Epi-ilumination) Through F2.8
Trans-illumination ‘White {Trans-illumination) Through FZ.6

1
105 x 70 mm
@1
Q2
) NP D
O 4

- 0K | Ccancel |

¢ Select Fluorescence as the Method, and choose EtBr from the pull-down menu.
The 605DF40 filter is automatically selected.

¢ Select the Tray position.
e Click the OK button.

ImageQuant LAS 4000 User Manual 28-9607-42 AB 43



4 Operating the ImageQuant LAS 4000
4.6 Exposing fluorescent samples (EtBr)

Step Action

Click the Focusing button.

Result: The focusing controls appear.

ImageQuant”™

LAS 4000 =
Exposure Type
Exposure Time
ks
oAl
| |
Sensitivity / Resolution

o By

2
i
[33: Brightness D [0 @ Adjust G [l
@@ YYD
Confirm the sample position and focus.
Click the Return button.
TIP: Click on the image to magnify it. Click on the image again to return to the original
size.
Select Precision for Exposure Type.
Exposure Type
3 Pt v Precision
ExposureT ~ Imerement
O futs| Repetition
® Manu Program
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4 Operating the ImageQuant LAS 4000

4.6 Exposing fluorescent samples (EtBr)

Step Action

Auto
Exposure Type
Exposure Time
@ Auto
O Manual
Note: Automatic exposure
time setting may
4 not be possible de-
pending on the
sample type and
method.

Select Auto or Manual for Exposure Time.

Manual

Select an exposure time from the drop-down list or enter
the exposure time manually. The exposure time can be
set from 0.01 seconds up to 30 hours.

Exposure Type

Exposure Time
[@F: T
® Manual
hr
Sensitivity min
v oseC
st
15hr
2hr

Add Digitiz,
[Jon

&0min
30min
10min
Smin
2min
Chemiluminesc 1rmin

1sec
1f2sec
1}4sec
Flat frame 1fasec

futa 1/15sec

1[30sec

1/6i0sec
1/100ser

Select Sensitivity/Resolution.

Sensitivity / Resolution
(| v High Resolution
Standard

High

Super

Ultra

High Einning

Super Binning
Ultra Binning

Sensifivity/Resalution

2 sorimapa

XSG

(Ter ]

TIP: Select Help:Sensitivity/Resolution.... This opens the following diagram that de-
scribes the relation between sensitivity and resolution.
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4 Operating the ImageQuant LAS 4000
4.6 Exposing fluorescent samples (EtBr)

Step Action

Click the Start button. The orange Busy LED lights on the instrument during exposure.

% |mageQuant LAS 4000
File Edt View Option Help
ImageQuant

LAS 4000

Exposure Type

Exposure Time
Auto

Marnal

Sensitivity / Resolution

High Resclution %

Exposire Time ¢ 30sec

Finishing Time : A 09:401

Exposing...

MERRRANNN
Fiuorescence
Flat frame
-
~ = @ ﬁ(,“"
Exposure Type | | .1
S NANSARNS
Exposure Time 2
s —-—==5
———
B S |
— -
— —
= -
1
|
1
|

b Print
é Save

ﬂ Complete

Click the Complete button.
The display returns to the main screen.

TIP: If the Method EtBr UV (Trans-illumination) is used, the Start button can be clicked and
exposure taken even if the temperature setting state of the CCD is Not Ready.
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4 Operating the ImageQuant LAS 4000

4.7 Exposing fluorescence (Epi illumination)

4.7 Exposing fluorescence (Epi illumination)

This section describes how to expose fluorescent samples using Epi illumination.

Ensure that the correct Epi lights and filter are installed. See Chapter 3 Exchanging accessory parts, on
page 17.

Place a sample on the Epi tray. Put the tray into the ImageQuant LAS 4000 and close the door.

Note: * Make sure that sample is suitably placed on the tray for the desired tray position.

* Ensure that a suitable method exists and that the ImageQuant LAS 4000 is properly
calibrated. See Section 4.16 Creating a new method and performing flat frame
calibration, on page 78.

% ImageQuant LAS 4000

Exposure Time
4 ——1= Oaume
© Manual

5 Sensitivity / Resolution
— Standard ¥

Add Digitization image
[]on

Flat frame
[auto
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4 Operating the ImageQuant LAS 4000
4.7 Exposing fluorescence (Epi illumination)

Step ‘ Action
Click the Method/Tray position button.
Result: The Method/Tray position dialog opens.
Method / Tray position
Method Light | ~ Filter | Iris
) Chemiluminescence Mone Through F0.85
(%) Fluorescence
[ [Cy3] ]| [ Green(Ep-rae) W] S7SOF20 F0.05
() Digitization
(=) Epi-llumination “White (Epi-llumination) Through F2.8
) Trans-ilumination white (Trans-ilumination) Through Fz.8
1 144 x 96 mm
Ot
®:2 |.2 |
O ’ " D
O+
‘ oK ] ‘ Cancel ]
e Select Fluorescence as the Method, choose the appropriate fluorescent marker and the ap-
propriate light source from the pull-down menus.
The appropriate filter is automatically selected.
e Select the Tray position.
e Click the OK button.
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4 Operating the ImageQuant LAS 4000

4.7 Exposing fluorescence (Epi illumination)

Step Action

Click the Focusing button.

Result: the focusing controls appear.

B jmageluant LAS 4000
Fia EQ Vew Oplon Heb
ImageQuant’

Exposure Type

Interval Time

CRla,
sensitivity / Resolution )

Skl L3

Repeat Limit
Ak ol
o | times (1..100)

2 —
(L]
Flat frame
[ Focusing [0l T Adjus
Confirm the sample position and focus.
Click the Return button.
TIP: Click on the image to magnify it. Click on the image again to return to the original
size.
Select Precision for Exposure Type.
Exposure Type
3 Pl v Precision
Exposure T Increment
O futo Repetition
@ Manui  Program
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4 Operating the ImageQuant LAS 4000
4.7 Exposing fluorescence (Epi illumination)

Step Action

Select Auto or Manual for Exposure Time.

Auto Manual
Exposure Type Select an exposure time from the drop-down list or enter
the exposure time manually. The exposure time can be
E""%“‘AM'EJ‘I"‘“ set from 0.01 seconds up to 30 hours.
Exposure Type
Note: Automatic exposure Exp
time setting may & e
4 not be possible de- 59 s
pending on the L &>
sample type and paDane o
method. Sy

Chemilumines: 1min

Flat frame l:BsEc
o vitme |
1130sec
1:605ec
1/100s8c
Select Sensitivity/Resolution.
Sensitivity / Resolution
[ v HighResolution
Standard
High
Super
Ulkra
High Binning
Super Binning
Ultra Binning
TIP: Select “Sensitivity/Resolution...” in the Help menu. You can display Help that de-

scribes the relation between sensitivity and resolution.
SensiivityRosolution

2 sorimapa
I Vsaax1024)

I

14285

(Ter ]

Click the Start button. The orange Busy LED lights on the instrument and a progress dialog is
displayed during exposure.
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4 Operating the ImageQuant LAS 4000

4.7 Exposing fluorescence (Epi illumination)

Step Action

B jmageluant LAS 4000

Fis Edt Vew Oplon Help

Adjust the gradations of the exposed image, then save and print the image.

ImageQuant’

LAS 4000

Exposure Type

[ Interval Time

ik
ECH | |
Sensitivity / Resalution

Repeat Limit
A
o | times (1..100)

oo EETEG Reset All

Click the Complete button.
The display returns to the main screen.

wh
ﬂ, Save

Complete

4.8 Exposing dye stained samples and films (White Epi light)

This section describes how to expose dye-stained samples using white Epi illumination.

For some applications, such as imaging gels stained with Coomassie Blue dye, results may not be
optimal using the white epi light. If the White trans tray is available, see Section 4.9 Exposing dye stained
samples and films (Trans illumination), on page 55 for a more optimal method.

Place a sample on the Epi tray. Put the tray in the ImageQuant LAS 4000 then close the door.

Note: . .
e Priortoexposure, click on the Digitiza-

tion Epi-illumination tab in Edit:Pref-
erence and make sure that YES is se-
lected for Invert Pixel-data. If this is
set to NO, the data will not be inverted
and the quantitative value will be re-
versed.
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4 Operating the ImageQuant LAS 4000
4.8 Exposing dye stained samples and films (White Epi light)

¥ ImageQuant LAS 4000
File Edit View Option Help
ImageQuant
LAS 4000

Exposure Type

3—
Exposure Time
4 —= Oauo
@ Manual

Sensitivity / Resolution

B Standard v

Add Digitization image
Clom

READY [ =T

Flat frame
| Auto

Chemiluminescence

Step Action
Click the Method/Tray position button.
Result: The Method/Tray position dialog opens.
Method / Tray position
) Chemiluminescence Mone Through F0.85
() Flunrescence
[ [Cya] v]| Green v 5750F20 FO.,85
() Digttization
(*) Epi-illumination “White (Epi-ilumination) Through Fz.8
() Trans-ilumination White {Trans-illumination) Through Fz.8
!
144 x 96 mm
(@l
®z
O ’ " D
O4
- 0K | Cancel |
e Select Digitization and Epi-illumination for Method.
e Select Tray position according to the sample used.
¢ Click the OK button.
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4 Operating the ImageQuant LAS 4000
4.8 Exposing dye stained samples and films (White Epi light)

Step Action

Click the Focusing button.

Result: The focusing controls appear.

£ ImageQusant LAS 4000
Fie Ed Vew Oplon Help
ImageQuant’

LAS 4000

Exposure Type
Exposure Time
ks |

e
N |- -
Sensitivity / Resolution
______ | [ |

... - ‘
2
rightness  [IR] [0 @@ Adjust [
Confirm the sample position and focus.
Click the Return button.
TIP: Click on the image to magnify it. Click on the image again to return to the original
size.
Select Precision for Exposure Type.
Exposure Type
3 Pl v Precision

Exposure T Increment

O futo Repetition

@ Manui  Program
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4.8 Exposing dye stained samples and films (White Epi light)

Step Action

Select Auto or Manual for Exposure Time.

Auto Manual
Exposure Type Select an exposure time from the drop-down list or enter
the exposure time manually. The exposure time can be
E""%“‘AM'EJ‘I"‘“ set from 0.01 seconds up to 30 hours.
Exposure Type
Note: Automatic exposure Exp
time setting may & e
4 not be possible de- 59 s
pending on the L &>
sample type and paDane o
method. Sy

Chemilumines: 1min

Flat frame l:BsEc
o vitme |
1130sec
1:605ec
1/100s8c
Select Sensitivity/Resolution.
Sensitivity / Resolution
[ v HighResolution
Standard
High
Super
Ulkra
High Binning
Super Binning
Ultra Binning
TIP: Select “Sensitivity/Resolution...” in the Help menu. You can display Help that de-

scribes the relation between sensitivity and resolution.
SensiivityRosolution

2 sorimapa
I Vsaax1024)

I

14285

(Ter ]

Click the Start button. The orange Busy LED lights on the instrument and a progress dialog is
displayed during exposure.
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4.8 Exposing dye stained samples and films (White Epi light)

Step Action

Adjust the gradations of the exposed image, then save and print the image.

£ ImageQusant LAS 4000

Fie ER Vew Oplon  Hep
ImageQuant”™

LAS 4000

Exposure Type
Exposure Tima
Ao 1
Rt .
= Bl _
Sensitivity / Resolution
o dadale |
. '
7 [ S '
- |

Flat frame
[to

£ Save

E] complete

Click the Complete button.
The display returns to the main screen.

4.9 Exposing dye stained samples and films (Trans illumination)

This section describes how to expose dye-stained samples using white trans illumination.
Place a sample on the White trans tray. Put the tray in the IDX and close the door.
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4.9 Exposing dye stained samples and films (Trans illumination)

¥ ImageQuant LAS 4000
File Edit View Option Help
ImageQuant
LAS 4000

Exposure Type
3—

Exposure Time
Y —t— O
@ Manual

Sensitivity / Resolution

I e rrr—

Add Digitization image
Clom

READY [ =T

Chemiluminescence

Flat frame
| Auto |

Click the Method/Tray position button.
Result: The Method/Tray position dialog opens.

Step Action

Method / Tray position
Method | Light

) Chemiluminescence More Thraugh FO0.85

) Fluorescence

[ [EtBr] | [ (Trans-llumination) ¥ ] GOSDF40 F2.8
(3 Digitization

() Epi-illumination ‘wihite (Epi-ilumination) Through Fz.5

(%) Trans-ilumination White (Trans-ilumination) Through Fz.6

!

105 x 70 mm
®1
(@5
(#i P D
Q4

| OK ]|Cance|]

1 Select Digitization:Trans-illumination for Method.
2 Select Tray position according to the sample used.
3 Click the OK button.
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4.9 Exposing dye stained samples and films (Trans illumination)

Step Action

Click the Focusing button.
Result: The focusing controls appear.

% ImageQuant LAS 4000
File Edit View Option Help

ImageQuant™
LAS 4000

Exposure Type
Exposure Time

Auto

Mariual

o
‘ Sensitivity /Resolution
-
|_J
2 - —
Flat frame
[[ 9% Brightness [ ]
Return
Confirm the sample position and the focus.
Click the Return button.
TIP: Click on the image to magnify it. Click on the image again to return to the original size.
Select Precision for Exposure Type.
Exposure Type
3 FI w  Precision
Exposure T Increment
O Auta Repetition
@ Manu Program
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4.9 Exposing dye stained samples and films (Trans illumination)

Step ‘ Action

Select Auto or Manual for Exposure Time.

Auto Manual
. Select an exposure time from the drop-down list or enter
posure Type
the exposure time manually. The exposure time can be set
S from 0.01 seconds up to 30 hours.
) Manual
Exposure Type
:
Note: Automatic exposure E————
time setting may not & o
4 be possible depend- - o
) ensitivity
ing on the sample [
Add Digitiz] "
type and method. Do 2"

&0min
30min
10min
Sriry
2min
Chemiluminesc rain

1sec
tjzsec

Flat frame 1:Bsec
E 1/15sec :|
1/30sec
1:605ec
1/100sec
Select Sensitivity/Resolution.
Sensitivity / Resolution
[ v HighResolution

Standard

High

Super

Ultra

High Binning

Super Binning

Ultra Binning

TIP: Select “Sensitivity/Resolution...” in the Help menu. You can display Help that describes
the relation between sensitivity and resolution.
5
SensivityRosolution
6 Click the Start button. The orange Busy LED lights on the instrument and a progress dialog is displayed

during exposure.
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4.9 Exposing dye stained samples and films (Trans illumination)

Step Action

Adjust the gradations of the exposed image, then save and print the image.

% ImageQuant LAS 4000
File Edit View Option Help

ImageQuant™
LAS 4000
Exposure Type
Precision ¥
[ Exposure fime
Auto ’
Manual o
[ ——
‘-Sensiti\;\ty /Resolution
I
.- 3]
7 e —— |
- ‘

Flat frame

‘L\te_D\g\t\zat\unTrans-lI\um\natmn_l ‘

Complete

Click the Complete button.
The display returns to the main screen.

4.10 Exposing consecutively (Increment)

The Increment exposure type enables a series of images to be exposed consecutively. The data for
each image is added to the previous images to provide accumulated exposure data. This section

describes how to perform this type of experiment.
Place a sample on the appropriate tray. Place the tray in the ImageQuant LAS 4000 then close the
door.

Note: e Make sure that the tray is placed at the required position.
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4 Operating the ImageQuant LAS 4000
4.10 Exposing consecutively (Increment)

2 imageQuant LAS 4000
Fle Edt View Opton  heb

Exposure Type
3— Inremerk v

Interval Time

4 —— 6w
10 bl b4
[ | Sensitivity / Resolution
Standard b
Repeat Limit
6 m Osetum

Step ction

Click the Method/Tray position button.
Result: The Method/Tray position dialog is opened.
e -

Method / Tray position
Method Light T

(%) Chemiluminescence Mone Through F0.85

) Fluorescence

[ [Cyz] | [ Blue v Y515 Di FO.85

O Digitization
(=) Epi-lumination “hite (Epi-llumination) Through F2.8
Trans-ilumination wehite {Trans-illumination) Through Fz.8

|
105 x 70 mm
@1 11 |
Q2
s []
O+

- 0K J\Cancel]

Select the Method and Tray Position.
Click the OK button.
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4.10 Exposing consecutively (Increment)

Step Action

Click the Focusing button.

Result: The focusing controls appear.

B jmageluant LAS 4000
Fia EQ Vew Oplon Heb
ImageQuant’

Exposure Type

Interval Time

Marsal

e

sensitivity / Resolution )

Skl L3

Repeat Limit
Ak ol
o | times (1..100)

(=4

Flat frame
ko

[ Focusing |8l [ Adjus

Confirm the sample position and focus.
Click the Return button.

TIP: Click on the image to magnify it. Click on the image again to return to the original
size.

Select Increment for Exposure Type.

Exposure Type

Repetition

@ Manu  Program

Select Interval Time unit and enter a numeric value.

Interval Time

(= Manual

l
Sensitivity / Res{ 2=

Repeat Limit
[ set Limit

Note: Interval Time can be entered in the range of 10 seconds to 2 hours.
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4.10 Exposing consecutively (Increment)

Step Action

Select Sensitivity/Resolution.

Sensitivity / Resolution

v High Reslution
Standard

High

Super

Ultra

High Binning
Super Binning
Ultra Binning

TIP: Select “Sensitivity/Resolution...” in the Help menu. You can display Help that de-
scribes the relation between sensitivity and resolution.
5
To specify the maximum number of exposures to be taken, check the Set Limit check box and
6 specify the number of images.

Repeat Limit
Sek Limit

times (1..100)
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4.10 Exposing consecutively (Increment)

Step Action

Note:

Index view

Click the Start button to begin exposure.
The index view and expanded view can be switched by clicking the Index or Image tab.
The displayed expanded image is the latest image.

Image view

DI

s

= Print
Apply All & Save
Reset All K1 complete

\\\\\

EE Index

Exposure automatically stops after the number of images set in Repeat Limit.

Note: Clicking the Stop button cancels the current exposure.

TIP: It is possible to stop exposures automatically when the image is saturated. This
2 function is activated in Edit:Preference under the Increment tab.

TIP: During exposure, the gradation conversion curve can be changed and the grada-

tion adjusted.

When the Apply All button is clicked, the adjusted gradation will be applied to all
images.

Description

The range can be changed by

dragging the mouse.

= o £ - n
fhied o]

Print

Description

The changed gradation is ap-
plied to all images.

The gradation conversion
curve can be toggled between
Linear or Sigmoid.

Return to initial setting.

The gradation can be
changed by dragging the
mouse.
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4.10 Exposing consecutively (Increment)

Action

Adjust the gradations of the exposed imagel(s) as described above, then save and print the image(s).
8 Click the Complete button.
The display returns to the initial screen.

Note: Only the last 100 images can be kept. Previous images are discarded.

4.11 Exposing repeatedly (Repetition)

The Repetition exposure type enables a series of images to be exposed consecutively. Each image is
recorded separately and data is not accumulated. This section describes how to perform this type of
experiment.

Place a sample on the tray that you selected according to the type of a sample. Put the tray in the
ImageQuant LAS 4000 then close the door.

Note: * Make sure that the tray is placed at the required position.

% ImageQuant LAS 4000 4 =] ]
Fle Lt vew Option el

g | Sensitivity / Resolution

Standad b

Repeat Limit
6 m Osetum
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4 Operating the ImageQuant LAS 4000
4.11 Exposing repeatedly (Repetition)

Step Action

Click the Method/Tray position button.
Result: The Method/Tray position dialog is opened.

®1
Ce
O3 NP
Ca

L1

Method / Tray position
ety Light Filter s
(%) Chemiluminescence Mone Through FO.85
) Fluorescence
[ [Cyz] v]| Blus Y515 Di F0.85
O Digitization
(& Epillumination twhite {Epi-ilumination) Through F2.8
Trans-illurnination white {Trans-illumination) Through F2.8

105 x 70 mm

[ ]

[ oK ] [Cancell

Click the OK button.

Select the Method and Tray Position.
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4.11 Exposing repeatedly (Repetition)

Step Action

Click the Focusing button.
Result: The focusing controls appear.

Exposure Type

Interval Time

Marusal
Sensitivity / Resolution

Repeat Limil
Set Lt
100 | times (1..100)

Plascescence
[Eva]

Flat frame
o

Confirm the sample position and focus.
Click the Return button.

TIP: Click on the image to magnify it. Click on the image again to return to the original
size.

Select Repetition for Exposure Type.

Exposure Type

Re  Pracision
R 3
Interval Tin  "™"¥"en
w Repetition

@ Manut  Program

Select Interval Time unit and enter a numeric value.

Interval Time

(&) Manual
hr

Sensitivity / Rest M

Standard B

Repeat Limit
[ set Limit

Note: Interval Time can be entered in the range of 10 seconds to 2 hours.
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4.11 Exposing repeatedly (Repetition)

Step Action

Select Sensitivity/Resolution.

Sensitivity / Resolution

v High Resolution
Standard
High
Super

Uttra

High Binning

Super Binning
Ultr Binning

TIP: Select “Sensitivity/Resolution...” in the Help menu. You can display Help that de-
scribes the relation between sensitivity and resolution.

Sensifivity/Resalution

XSG

(Ter ]

To specify the maximum number of exposures to be taken, check the Set Limit check box and
specify the number of images.

Repeat Limit
Set Limit

times (1..100)
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4.11 Exposing repeatedly (Repetition)

Step ‘ Action

Click the Start button to begin exposure.
The index view and expanded view can be switched by clicking the Index or Image tab.
Note: The displayed expanded image is the latest image.

Index view Image view

DI

s

— - Print
- Apply All 5SS B Save
Tpig | e | E] Complete

s = Print
L Apply All & Save
2t Reset All K1 complete

Exposure automatically stops after the number of images set in Repeat Limit.

Note: Clicking the Stop button cancels the current exposure.
7 TIP: During exposure, the gradation conversion curve can be changed and the grada-
tion adjusted.

When the Apply All button is clicked, the adjusted gradation will be applied to all
images.

i Apply All
Reset All

Description s Description

1 Therange canbe changedby | 4 The changed gradation is ap-
dragging the mouse. plied to all images.

2 The gradation conversion 5 Return to initial setting.

curve can be toggled between
Linear or Sigmoid.

3 The gradation can be
changed by dragging the
mouse.
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4.11 Exposing repeatedly (Repetition)

Action

Adjust the gradations of the exposed image, then save and print the image.
8 Click the Complete button.
The display returns to the initial screen.

Note: Only the last 100 images can be kept. Previous images are discarded.

4.12 Printing exposed images

The exposed image can be output as a full-scale print or screen print (the window displayed on the
screen). The print can be done using the Print button displayed in the post-exposure state or the
File:Print. This section describes how to print an image.

Step Action

For a screen print, first display the window you wish to output.

1

Click the Print button or select Print from the File menu.

Select the output setting for the printer and the type (full-scale print, paper-size print or screen

print). Click the OK button.

Full-scale print
Paper-size print  — O et
2 Screen print PR
print ]
= (=]

The Print dialog is displayed. Choose settings for the printer and click the Print button.
The image is printed.
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4.12 Printing exposed images

TIP: Exposure information is printed together with the image (except for the Easy Print
option). This is convenient since it is unnecessary to note the exposure information and
the conditions. The following exposure information is included:

Exposure date, camera serial number, lens type, cooling temperature at the time of
exposure, exposure type, sensitivity, exposure time (or interval time), name of Method,
tray position number, values at both ends of the range scope, values at both ends of
the gradation, type of gradation, Control Software version number.

Nov Wed 25 15:25:14 2009 Serial#1234567 FUJINON VRF43LMD Cooling:-25C
Precision Standard 1sec Chemiluminescence Tray Position 1
Range:512-4607 Gradation:512-4607 Linear ImageQuant LAS 4000 mini 1.1.0.17

Image

4.13 Saving exposed images

The exposed image can be saved using the Save button displayed in the post-exposure state or by
File:Save. This section describes how to save an image.

Action

1 Click on the Save button or select File:Save.
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4.13 Saving exposed images

Step Action

the photographed image.
Click Next button.

1 (®) Save selected images

2 () save displayed images

3 Make integrated image

4 Save passed images | Up to 84 images )

When the Save Function screen is displayed, select one of the following 3 saving methods to save

s Mk M

Comment :

[ ek ][ Cancel ]

Description

Description

Program)

(Exposure Type: Increment, Repetition,

All image files displayed in the index
view are saved (maximum 16 files).

1 Save Selected Image 4 Save Images in temporary folder
2 (Exposure Type: Increment, Repetition, (Max84)
Program) Image files not displayed in the Index
For multiple files, specify the range of view are saved in the 100 latest im-
files to be saved. ages (maximum 84 files).
2 Save Display image (Max16) 5 Comment

When the file is saved in gel format
(*.gel), a comment can be entered in
the file.

When the file is saved in TIFF format,
the comment will not be saved.

3 Make Increment Image

mulated and saved.

fied.

(Exposure Type: Program only)
Files of multiple exposures are accu-

The range of image files to be pro-
cessed in accumulation can be speci-
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4.13 Saving exposed images

Step Action

The Save dialog is displayed. Type in a File name and press the Save button to save the file.

Save

Save in: I@ LAS4000Image _I 4=y 1

My Recent
Documents

My Documents

by Computer

&

Myprliect:asork File name: I ] — 1 2
3 Save ag tppe: IGeI File Format(*. gal] —LI%I— — 3
A
No. ‘ Description
1 Select where to save the file.
2 The file name is set automatically but may be replaced.

File names for single and programmed exposures are automatically set in the
format <FileName>_n, where n is the next available index. For images taken
in exposure type Increment, file names are automatically set in the format
<FileName>_n_N_<TotalTime>, where n is the next available index, N the total

number of exposures and TotalTime is the total exposure time for the image.

3 Select a file format. The .gel format is a GE Healthcare format that records
details of the exposure. Such details are not saved in .tif format.

TIP: To automatically launch an external application to view images upon saving, refer to
Launch Applicaton, on page 98.

Note: Special characters such as \, * / or other characters that have a special meaning in
Windows should not be used in a file name.

4.14 Ending the session

This section describes how to end the current session with the ImageQuant LAS 4000. The instrument
should be switched off as described below when it will not be used for some time.
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4.14 Ending the session

Step Operation

Select Quit from the File menu.

% ImageQuant LAS 4000
GEM Edit  Wiew Option  Help

1 Page Setup... nt"

Print... Chrl+P i

() Skop the CCD cooling now.

() Keep the CCD cooling after quit,

Co ] [o= ]

TIP: When Keep the CCD cooling after quit is selected, the cooling temperature of
the CCD will be maintained and the instrument can be used straight away the
next time the ImageQuant LAS 4000 Control Software is started. In this case, do
not turn off the ImageQuant LAS 4000. However, if the instrument will not be used
for a long period, it should be turned off.

3 Shut down the computer.

4 Switch the ImageQuant LAS 4000 off using the power switch.

4.15 Exposing large sample using wide view lens

A larger sample (of up to 250 x 250 mm) can be exposed by replacing a high-sensitivity lens with a
wide view lens. This section describes how to expose large samples.

Action

1 Install the wide view lens. See Section 3.2 Installing or exchanging the lens, on page 18.
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4.15 Exposing large sample using wide view lens

Step Action

Place a sample on the tray that you selected according to the light source used.
Put the tray in IDX and close the door.

% ImageQuant LAS 4000
File Edit Yiew Option Help
ImageQuant
LAS 4000

Exposure Type

Exposure Time
Auto
&) Manual

Sensitivity / Resolution

Standard hd

2 Add Digitization image
don

READY [

Chemiluminescence

Flat frame
| At

% Method/Tray position
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4.15 Exposing large sample using wide view lens

Step Action

Click the Method/Tray position button.

Ca
®t L1 |
Oz

O3 NP

Method / Tray position
Method Light Filter Iris
() Chemiluminescence MNone Thraugh Fil, &5
(%) Fluorescence

[ [EtEr] ] [ v (rans-luminatiory ] G0S0F40 F2.
O Digitization

(%) Epidllumination ‘white (Epi-illumination) Thraugh F2.8

Trans-illumination Shite {Trans-ilumination) Through Fz.&

105 x 70 mm

[

Prev ‘ Next ] ‘ Cancel]

O N S

Click the OK button.

Select the appropriate Flat Frame file.

Select the Method, Light source, Filter, Iris, and Tray position.

If FlatFrame Mode is set to manual in Edit:Preference, click the Next button.
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4.15 Exposing large sample using wide view lens

Step Action

Click the Focusing button.

adjust the focus manually.

% ImageQuant LAS 4000

File Edt View Cption Help

ImageQuant™
LAS 4000

Exposure Type

Exposure Time
Auto

@ Manual
'-Sens{fivity /Resolution

High Resolution %

Flat frame

I

Using for example some printed text on the sample tray, turn the lens while viewing the screen, and

w_:' \ n&g{ﬁ.ﬂﬁﬂi w

% Method/Tray position

Click the Return button.

TIP: Click on the image to magnify it. Click on the image again to return to the original size.

Select Exposure Type.
Exposure Type

5 Pi w  Precision

Increment

Exposure T
O Auka Repetition
@ Manu Prograrn

6 Set the Exposure Time or Interval Time.
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4.15 Exposing large sample using wide view lens

Step Action

Select Sensitivity/Resolution.

Sensitivity / Resolution

v High Resolution
Standard
High

Super
Uttra

High Binning

Super Binning
Ultr Binning

TIP: Select Sensitivity/Resolution... in the Help menu. You can display Help that describes
the relation between sensitivity and resolution.
7
g Click the Start button.
Exposure is started.
Adjust the gradations of the exposed image, then save and print the image.
Click the Complete button.
% ImageQuant LAS 4000
" imogeQuant”  FETTTIS ]
LAS 4000 H Lo
I
Exposure Type i iy
4
Exposure Time ‘ )
® Qu;nﬂua\ :
=~
Sensitivity / Resolution s
9
Flat frame

'

The display returns to the main screen.

Kl Complete
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4.16 Creating a new method and performing flat frame calibration

4.16 Creating a new method and performing flat frame
calibration

For most purposes a pre-existing method will be sufficient. For other filter, light source and iris
combinations a new method needs to be created. The following describes how to create a new method
and perform a Flat Frame calibration.

Step ‘ Operation

In Preference in the Edit menu, select FlatFrame mode, and set this to Manual.
1
= (=]
To create a new method click Method Setting in the Option menu. The Method Setting dialog
opens.
Methad List
Mame: Light Filter Tris e
[Cyz (RGB)] B 5ius EpiRaE) @ o Foss
[cvz] B slue Epiblue) @ =150 Foss
2 [Cy3 (REEY] Bl creen (Epi-reE) @ swsoFz0 Fo.sS
[cy3] B Green (Epi-Green) @ S7SDFz0 FO.85
[CyS (RGEY] I red (EpinaE) @ rsmo F0.85 |
[Cys] Il Red (Epired) @ rso FO.85
[DAPI] | - E{=ETh] [~ TN F2.6
[Digitization Epi-ilumination] O white (Epirwhite (O Through | Fz.s
[Digitization Trans-ilumination] 8 white (Trans-white) () Through | F2.8 hd
Select an existing method to change and click the Edit button, or to create a new method click
Add.
The Method Setting edit dialog opens.
3 Mame: | TomsMethod |
Light: ‘.B\ue(Ep\-BluE) v‘
Fiter: | @ R7s0 v‘
Tris: ‘FD‘EE v‘
4 Select the appropriate Light, Filter and Iris, edit the Name for the method and click OK.
Once the method is added to the list of methods, click OK to return to the main window.
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4.16 Creating a new method and performing flat frame calibration

Step Operation

Insert the calibration plate appropriate for the light source into the ImageQuant LAS 4000.

Light source  Calibration plate

Red Epi light Cal plate GR (pink)

Green Epilight = Cal plate GR (pink)

Blue Epi light  Cal plate FL (green)

5 RGB module Use the Cal plate that corresponds to the chosen wavelength (red, green or
blue)

NIR Epi light Cal plate GR (pink)

UV Epi light Cal plate FL (green)

White Epi light = Cal plate DI (white)

Close the door of the instrument.
Note: Ensure the the appropriate lights and filter are in place.

To perform a Flat Frame calibration, select FlatFrame Calibration in the Option menu.
The FlatFrame Calibration dialog opens.

6
=T
Note: Administrator priveleges are required in order to perform a Flat Frame calibration.

7 Select t.he method to cglibrote from t.he drop-down list. Choose which tray positions to calibrate,
then click Start to begin the calibration.

8 Once the calibration is complete, click the Close button to close the dialog. The calibration plate

can now be removed.
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5 Software reference guide

5 Software reference guide

5.1 Exposure type

This function is for selecting exposure methods. There are four types of exposure methods.

Exposure Type Description

Precision Exposes for the entire time set in Exposure Time.

Increment Exposes for each time set in Interval Time and accumulates images.

Repetition Exposes for each interval time set in Interval Time and displays images for each
section.

Program Exposure is made for the desired time and exposure intervals. A file is created
automatically for each read image, and the file of accumulated images is also
saved automatically.
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5 Software reference guide
5.1 Exposure type

Precision[  —~——~~~"""""""""""__ ~" """ "o T T
Sets the exposure time i D>
and creates one image] _ _ _ _ _ _ _ _ _ L _ o o o e e e e e e Z
Increment—m >
Sets the exposure —'Image 1
interval and creates
multiple accumulated W+ | >
images. Image 2
B+ W+ H D> Image 3
Image 3
Repetition—HX >
Sets the exposure | Imaga 1
interval and created
multiple images. |:., >
Image 2
—a>
Image 3
Prog ramms:l >
Dasired exposure time Inlﬁ
and exposure interval
are set, and multiple >
images are created. Image 2
Exposure interval (Wait) R >
presst in Image 2. Image 3
Exposure interval (Wait) | >
preset in Image 1. Exposure interval (Wait) mage 4
preset in Image 3. T2 ™ @ 1
{File enly)
Exposure intarval {Wait)
preset in Image 4.
-

Exposurs time

5.2 Exposure time

This function is for setting the exposure time.

When exposure

type is precision

e Auto: The exposure time is automatically calculated by histogram analysis.
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5.2 Exposure time

Manual: Select a suitable exposure time from the drop-down list. Alternatively select a time unit
and type in an exposure time.

Exposure Time
Auto

® Manual
10 b

Sensitivity /| ™"
v seC
High
15hr
2hr

B0min
30min
10min
Smin
Zmin
Chemiluminesce 1min

1sec

1j2sec
1jasec
Flat frame 1f8sec

Auto 1/15sec :l
1/30sex
‘ 1/60sec
- 110058

When exposure type is increment or repetition

Choose a time unit from the drop-down list and enter an interval time.

Interval Time

® Manual
v O w

Sensitivity / Res( """

TIP: The interval time can be set from 10 seconds to 2 hours. For a UV transmitting light

source, the interval time can be set from 10 seconds to 1 minute.

Note: An image can be exposed for up to 30 hours in Precision mode. However, the image

quality and quantitative performance are only guaranteed for a maximum of 2 hours.

5.3 Add digitization image

Add Digitization image
Ol

A chemiluminescence and a white-light epi-illuminated image are exposed by single-click operation

when this function is set to ON. After exposure, both chemiluminescence and white epi-illuminated
images can be saved.

This function can be used only when the method is chemiluminescence.
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5.3 Add digitization image

TIP: Click on Digitization Epi-illumination in Preference in the Edit menu, and select YES

for Invert Pixel-data.

<D Conling

Root Folder

File Format:

FlatFrame Mode

Launch Application

Brint Adjust

Increment;

Digitzation Epi-lumination
Timer

Auto Range

Tnvert pixel data

@© ¥Es Ono

5.4 Program settings

Program Settings are used to set exposure time and exposure intervals when Program mode is
selected as Exposure Type. The input settings are saved as a template file.

12 11

Program Exposure Setting

1 —_— Tew Temp}‘te / vl

Template: |

Image 1 Image 2 Image 3 Image 4
2 T wa L Lo w] war o [eecw] wae [0 [ecw] wa [0 [ ]
Image 5 Image & Image 7 Image &
wait [ Tl w] | war CH = e o el o o [l
Exposure Exposure Exposure Exposure
Image 9 Image 10 Tmage 11 Image 12
wae 0 [ v e o [ecw] fuw [ (vl ww [ [ v]
Exposure pmmre L Lo | | g [0 (o= | mgwmes
Image 13 Image 14 Image 15 Image 16
RS CH 2 1 S I I S OO IE2 ™ PR P
Exposure Bgosue |1 | s %] | exposwre (1 | sec ¥] | Exposurs
9 ——
File name : File Format : |

Sensitivity

Exposure Counk

Template Comment :

110

Gel File Farmat(*.gel)

¥|
8

Save Folder |C:1Ducuments and 5....ant LAS 40004 Image | Select....
4 _|
— i Save As Template ] ’ Reset ] \

5 6 7
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5.4 Program settings

No. Description No. Description
1 Atemplate file is selected. If a new template | 7 Select the image file format to be saved.
is to be created, select New Template. Note: Two types of format can be
Note: When the selected template selected, the GE Healthcare
is modified, Modified will be gel format (*.gel) and a linear
displayed. 16-bit grayscale tiff file for-
mat (*.tif).
2 Set exposure intervals. This is the time from | 8 Close the settings window.
the shutter closure until the start of the next
exposure.
Note: The wait time can be set
within the range of 0 seconds
to 30 hours.
3 Set exposure time. 9 Enter a file name to be saved.
Note: This can be set within the
range of 0.01 seconds to 30
hours.
4 Save the template. 10 Enter a comment.
5 Settings will return to the initial settings. 11 Select the number of frames (between 1 and
16) to be preset.
6 Folder in which the template is saved 12 Select detection sensitivity.

Delete a template
Navigate to the folder chosen in step 6 above and delete the template file.

The default locations are as follows:

* For Windows XP

C:\Document and Settings\All users\Application Data\GE Healthcare\ImageQuant LAS

4000\ProgramTemplate

* For Windows Vista

C:\GE Healthcare\ImageQuant LAS 4000\ProgramTemplate

5.5 Focusing

The Brightness function enables adjustment of the brightness of the Focusing screen, and the Adjust
function enables adjustment of the focus when the LAS High Sens. lens is used.
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5.5 Focusing

£ ImageQuant LAS 4000
File Edit Wiew Option Help

ImageQuant™
LAS 4000

Exposure Type

Exposure Time
Auto
Manual

O

Sensitivity / Resolution

High Resolution v

Flat frame
|Auto

Description
1 Click on the image to expand or reduce the | 4 Coarse adjustment of focus.
display.
2 The view of the focusing screen becomes 5 Fine adjustment of focus
darker.
3 The view of the focusing screen becomes
lighter.
TIP: Select Pan Focus Fast in the View menu. The focusing speed then increases.

This is effective for the alignment of a sample (see Pan Focus Fast, on page 104).

Note: e Whenthe NP tray is used, adjust so that the bottom of a plate is focused. Adjustment
using a printed paper facilitates focusing.

* Check the tray positions to be exposed in advance.

5.6 Start

Exposure starts when you click the Start button.
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5.6 Start

During exposure (type Precision)

86

During exposure, a progress bar and ending time are displayed to indicate the progress status of
exposure.

% ImageQuant LAS 4000
File Edit W“ew Option Help
ImageQuant’
L ';: 4 '\; _‘-'.J

Exposure Type

Exposure Time
Auto
Manual

30 sec W

Sensitivity / Resolution

Exposure Time @ 30
High Resalution hd e =8c

Finishing Tirme ¢ &AM 09:40

Exposing...

Fluorescence

[EtEr]

Flat frame
Auko

Cancel

Click Cancel to discontinue exposure. The current image is not saved.
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During exposure (type Increment or Repetition)

5 Software reference guide
5.6 Start

1 Range Scope can be changed by dragging | 5 The changed gradation is applied to all im-
the mouse. ages.

2 Gradation can be changed by dragging the | 6 Exposure is discontinued.
mouse. The current image is discarded.

3 Gradation conversion curve can be changed | 7 Click this tab to enter index view.
(linear or sigmoidal).

4 Returns the gradation to the initial setting. | 8 Click this tab to magnify the selected image.

TIP: * Exposure is interrupted when you click the Stop button during Precision exposure.

In this case, the image in course of exposure is not saved.

e When you click the Apply All button during magnified image display, the gradation
changed in the expanded image display state is applied to all magnified images.

Note: Only the 100 latest exposed images can be saved for exposure types Increment and

Repetition.
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5.6 Start

During exposure (type Program)

10

Expasure Type
Progran -

Program Settings
Terglate

Description E Description
1 The range can be changed by dragging the | 6 Exposure is discontinued.
mouse. The current image is discarded.
2 Gradation can be changed by dragging the | 7 Click this tab to enter index view.
mouse.
3 The gradation conversion curve can be 8 Click this tab to magnify the latest image.

changed (linear or sigmoidal).

4 Return to initial setting. 9 Preset conditions.
5 The changed gradation is applied to allim- | 10 The area where an image will be displayed.
ages.
TIP: * Images for which exposure is completed are automatically saved in a file with name

format: <FileName>_<PhotographNo.>_<ExposureTime>

* Animage, which is the accumulation of all exposed images is saved in a file with
name format: <FileName>_<Sum>_<TotalExposureTime>

Note: Only the 16 latest exposed images can be saved for exposure type Program.
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After exposure (type Precision)

5 Software reference guide

Fla Gde Ve Opion e

ImogeQuant™
LAS 4000

Exposure Type

5 el
1 T | e |
Semsitivity / Resolution
[ et ]

5.6 Start

Description Description

1 The range can be changed by dragging the Print image or screen.
mouse.

2 Gradation can be changed by dragging the Save image.
mouse.

3 The gradation conversion curve can be Return to main screen.
changed (linear or sigmoidal).
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5.6 Start

After exposure (type Increment, Repetition or
Program)

For magnified image view For index image view
9
8
< I _— - Print
Save Apply All £ Save 7
E] complete Rgset All E] Complesg

Description : Description
1 The range can be changed by dragging the | 6 Return to main screen.
mouse.
2 Gradation can be changed by dragging the | 7 Save image.
mouse.
3 The gradation conversion curve can be 8 Print image or screen.
changed (linear or sigmoidal).
4 The changed gradation is applied to all im- | 9 The selected image is marked by a yellow
ages. frame. Click on animage to select it. Double-

click animage or click the Image tab to open
the magnified image view.

5 Returns the gradation to the initial setting.

5.7 Sensitivity/Resolution

This function sets the sensitivity and resolution.
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The relation between the sensitivity and resolution is shown below.

SensiivityRosolution

File size for each sensitivity

5 Software reference guide
5.7 Sensitivity/Resolution

High Resolution  12.6MB
Standard 3.15MB
High 3.15MB
Super 3.15MB
Ultra 3.15MB
High Binning 786MB
Super Binning 197MB
Ultra Binning 49.2MB
TIP: Select Sensitivity/Resolution... in the Help menu. The relation between the sensitivity

and resolution is displayed.

5.8 Method/Tray position

The window for setting the method and tray position is displayed when you click the Method/Tray
position button. Select a method and tray position most suitable for the sample and click the OK button.
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5.8 Method/Tray position

Method / Tray position
bt Light Filter s
(&) Chemiluminescence Mone Through FO0.65
() Fluorescence
[ [Cy2] v| [ Biue v| V515 Di F0.685
O Digitization
(%) Epi-ilumination White (Epi-illuminatian) Through F2.8

Trans-illumination sthite {Trans-illumination) Through F2.&

Tray position

105 x 70 mm
®1
(@)
O 3 D
O 4

{ O K I ‘Cancell

Set the method and tray position
Method
The method (the combination of the optimum light source, filter, and iris) is registered for each detection

method. When a method is selected, the light source, filter, and iris are set automatically. The contents
of each setting are shown in the table below.

Note: The RGB module may be used instead of the separate red, green and blue Epi lights.
Method Option Light Filter ‘ Iris
Chemiluminescence None Through F0.85
SYBR Green Blue (460nm Epi) Y515 Di F0.85
GFP Blue (460nm Epi) 510DF10 F0.85
EtBr UV(312nm Trans-illumi- | 605DF40 F2.8
nation)

Fluorescence Cy2 Blue (460nm Epi) Y515 Di F0.85
Cy3 Green (520nm Epi) 575DF20 F0.85
Cy5 Red (630nm Epi) R670 F0.85
Dy781 NIR (710nm Epi) IR785 F0.85
DAPI UV (365nm Epi) L41 F2.8
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Method

5 Software reference guide
5.8 Method/Tray position

gt

Filter

Digitization Epi-illumination  White (Epi-illumination) | Through F2.8
Trans-illumina- White (Trans-illumina- | Through F2.8
tion tion)

Note: The method that can be used varies depending on the state of the light source set in IDX.

Unusable options cannot be selected.
Note:

Note: Filter position 1 is dedicated for chemiluminescence. Do not put a filter in it.

Before clicking the OK button, be sure to close the IDX door.

Tray position

The tray position is changed according to the sample size.

The tray size that can be read varies depending on the tray position.

Position Width (mm) Length (mm)
1 105 70
2 144 96
3 180 120
4 210 140
250 (wide view lens) 250 (wide view lens)

— 210mm

[ 7 7 25mm 250mm T T

140mm

180mm

120mm

T44mm

96mm

105mm

70mm

osition

I Position 3

I Position 4

Maximum exposure size when a wide view lens is used

TIP: ¢ The display on the main window changes to reflect the current choice of method

and tray position.

* The NP tray is to be used at tray position 3 using the Chemiluminescence method
and the NP check box should be checked. The tray will not be detected otherwise.
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5.8 Method/Tray position

Manual flat frame mode

In order to be able to manually specify a Flat frame file for the method and tray position, set FlatFrame
Mode to Manual in Edit:Preference. Click Next in the Method/Tray position dialog to select the
appropriate Flat Frame Correction.

ImageQuant LAS 4000 Preference

ZCD Cooling

Root Folder

Fil= Format

FlatFrame Mode

Launch Application

Print Adjust

Increment

Digitization Epi-ilumination
Timer

Auka Fange

(*) auto () Manual

TIP: Only Flat Frame files that satisfy the currently selected exposure conditions are displayed
in the Flat Frame Correction list.

To create a Flat Frame file, see the description of the Flat Frame Calibration function,
Section 5.12.2 Flat Frame Calibration, on page 105.

Note: Before clicking the OK button, be sure to close the instrument door.

5.9 File menu

Page Setup

Opens the settings for the printer, for example the direction of paper.

Print

Outputs an image to a printer.

The image can be printed as a full-scale print or screen print. For the output method, see Section 4.12
Printing exposed images, on page 69.
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5.9 File menu

Save

Saves a file. The default setting for the file format to be saved is that selected in Preference in the Edit
menu. See Section 5.10 Edit menu, on page 95.

Quit

Exits ImageQuant LAS 4000 Control Software.

5.10 Edit menu

Cut
Cuts the selected characters. This function can be used during manual input of exposure time and
interval.

Copy
Copies the selected characters. This function can be used during manual input of exposure time and
interval.

Paste

Pastes the copied characters. This function can be used during manual input of exposure time and
interval.
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5.10 Edit menu

Preference
The available settings can be viewed by clicking the respective item.

CCD Cooling
Sets the CCD temperature.

ImageQuant LAS 4000 Preference

CC0 Cooling

Fook Folder

File Format

FlatFrame Mode

Launch Application

Print adjust

Increment

Digitization Epi-ilumination

Timer CZD Cooling Temperature
Auko Range

Root Folder

Sets the folder in which files are saved.

ImageQuant LAS 4000 Preference

ZZ0 Cooling

F.oot Folder

File Format

FlatFrame Mode

Launch Application

Print Adjust

Increment

Digitization Epi-ilurnination
Timer

Auko Fange

C\Documents and Setkings\TE. . . .ts\ImageQuant LAS 4000 Image | ’ Select...
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5.10 Editmenu

File Format
Select the default format for saving images.

ImageQuant LAS 4000 Preference

0 Cooling

Rk Folder

File Format

FlatFrame Mode

Launch Application

Print Adjust

Increment

Digitization Epi-illumination
Timer

Auto Range

Gel File Farmat(®, gel) w

e Gel File Format (*.gel)

Linear 16-bit grayscale encoding. Can include additional information compared to .tif format.
¢ Original Image TIFF File-Linear 16bit Gray (* tif)

This is a 16-bit TIFF format.
e Window Image TIFF File-8bit Color (* tif)

This is a TIFF format that has an eight-bit color gradation.

The changed gradation can be saved directly.
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5.10 Edit menu

FlatFrame Mode

ImageQuant LAS 4000 Preference

ZZ0 Cooling

Fook Folder

File Format

FlatFrame Mode

Launch Application

Print adjust

Increment

Digitization Epi-ilumination
Tirner

Auko Fange

(¥} aAuto () Manual

(0] o}d[o]] Description

Auto Optimal correction data is automatically set.
Manual Correction data can be selected in the Flat Frame selection screen.
Launch Applicaton

This option can be used to automatically launch an external application when an image is saved.

ImageQuant LAS 4000 Preference

ZZ0 Cooling

Fook Folder

File Format

FlatFrame Mode

Launch Application

Print adjust

Increment

Digitization Epi-ilumination
Timer

Auko Fange

| C)

[] activate save and launch Function
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To define an application to launch, do the following:
[ )

Select... button.

¢ Check the Activate save and launch function checkbox.

5 Software reference guide
5.10 Editmenu

Select the application to be launched from the drop down list, or locate the application using the

Print Adjust
Adjusts the print output size.

ImageQuant LAS 4000 Preference

CCD Cooling

Ruoot Folder

File Format
FlatFrame Mode
Launch Application

Print Adjusk

Increment

Digitization Epi-ilumination

Timer

Auko Range width

Yo

o

Cancel
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5.10 Edit menu

Increment

ImageQuant LAS 4000 Preference

ZZ0 Cooling

Fook Folder

File Format

FlatFrarme Mode

Launch Application

Print adjust

Increment

Digitization Epi-illurmination Stop aukomatically when saturated
Tirner

Auko Fange

{(#) YES () Mo

(0] o}d[o]] ‘ Description

YES During incremental imaging, exposure is automatically stopped when the amount of satu-
rated data is too large.

NO During incremental imaging, exposure is continued until the Stop button is pressed.
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5.10 Editmenu

Digitization EPI

ImageQuant LAS 4000 Preference

0 Cooling

Rk Folder

File Format

FlatFrame Mode

Launch Application

Print Adjust

Increment

Digitization Epi-illumination

Tirer Invert pixel daka
Auka Range

(¥) ¥ES N s]

Option Description

YES Pixel data inversion is performed.

NO Pixel data inversion is not performed.
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5.10 Edit menu

Timer

ImageQuant LAS 4000 Preference

ZZ0 Cooling

Fook Folder

File Format

FlatFrarme Mode

Launch Application

Print adjust

Increment

Digitization Epi-ilumination

Timer Cooling Stop Timer
Auko Fange

1 hr w

If the ImageQuant LAS 4000 is not used during the chosen time, the cooling will be automatically shut
off and the system will enter power saving mode.

Auto Range

ImageQuant LAS 4000 Preference

CCD Cooling
Root Folder

File Format Auto Range selection in Repetition/Increment mode
FlatFrame Mode

Launch Application
Prink Adjusk (%) Mone | J |
Increment

Digitization Epi-ilumination

Timer _
Auto Range () semiaukomated |“ |

) Automated u

An image whose gradations are adjusted automatically is displayed when exposure type is Increment
or Repetition.

e None
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5.10 Editmenu

An image is displayed without adjusting its gradations.
* Semiautomated

An image is displayed with its light and shade highlighted.
* Automated

An image is displayed with its light and shade more highlighted. (The effect is the same as when
exposure type is Precision.)

5.11 View menu

Paint saturated data red

This function toggles whether to display saturated data in red.

Negative Gray

This sets the display color of an image such that absorbing bands are darker and the background
lighter.

Positive Gray

This sets the display color of an image such that absorbing bands are lighter and the background
darker.

Red

This sets the display color of an image such that illuminated regions are displayed in red.
Green

This sets the display color of an image such that illuminated regions are displayed in green.
Blue

This sets the display color of an image such that illuminated regions are displayed in blue.
Pan Focus All

This function toggles the quality of a focus image. The image is displayed in high image quality when
this option is selected.
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5.11 View menu

Pan Focus Fast

This function toggles the quality of a focus image. With this option selected the image quality is lower

than using Pan Focus All, but it is displayed faster.

TIP:
selected.

5.12 Option menu

5.12.1 CCD Calibration

During sample alignment, a sample can be quickly aligned when Pan Focus Fast is

This function creates a correction file that is used for correcting characteristics of the CCD detector.
The created correction file varies depending on the sensitivity, exposure time (short or long), and CCD

cooling temperature.

1 When CCD Calibration is selected in the Option menu, the following window is shown.

5 3 1

CCD Celibration

4

Currank Temperature -25

’ from 1,1"100 sec to 2 hours ] ’

over 2 hours

Ready

D Thu Jul 2 14:50:16 2009 D
D Thu Jul 2'-\‘1??:::31 2009 D
r Thu Jul 2'-\‘:16::;:31 2009 U
0 Thu Jul 2R1ia::;:31 2009 r
D Thu Jul 2'-\‘1?3::2:31 2009 D

Total Time for Calibration @ 0 minukes

Mot Ready

Stark Stop

Description

Description

played.

104

1 Click here to check the boxes forall | 4 Click here to check the boxes for all
resolutions for up to 2 hours. resolutions for more than 2 hours.
2 The time required for creation is dis- | 5 Click on the buttons in this column to

check the boxes for both correction
files for specific resolutions.
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5.12 Option menu
5.12.1 CCD Calibration

No. Description

No. Description

3 Check individual check boxes to
generate specific correction files.

2 Click the Start button to generate the file.
¢ The progress of file creation is shown on the progress bar.

¢ To stop file creation, click the Stop button. The file will not be saved.

5.12.2 Flat Frame Calibration

This function creates a correction file (Flat Frame) that is required for correcting the optical
characteristics. The Flat Frame file varies depending on Light, Filter, Iris, and Tray Position.

Note: Administrator priveleges are required to perform Flat Frame calibration.

Flat Frame Calibration

1 Select Flat Frame Calibration in the Option menu. The window below is then displayed.

[Digtizstion Epi-llurinstion] ¥
fpplicabls Tray EFI Tray
Uniformity Standard Calibration Plate 0T
Callbrsts, Al Tray Pasition
Tray Position 1 O IFety
SUn My 31 115,22 200
R
Tray Position 2 IF CERY
Mon May 25 14:16:55 2002
R
Tray Position 3 IF CERY
Mon May 25 14:17:36 2002
Read
Tray Position 4 O (=Y
Mon May 25 14:18:16 2002
Total Time for Calbration : @ mindtes
Start Stop

2 Select a method from the drop-down menu at the top.

3 Put the displayed tray and Calibration Plate in the instrument.

4 Select the condition to be created.

5 Click the Start button.

Note:

Make sure that an appropriate filter and tray are in place.

6 A message window opens when the calibration is completed. Click OK.

7 Click the Close button to close the FlatFrame Calibration window.
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5.12 Option menu
5.12.2 Flat Frame Calibration

Flat Frame Calibration Pro

1 If FlatFrame Calibration Pro is selected in the Option menu, the window of the conditions preset

in the Method/Tray position window will be displayed.

Light Filter
‘wihite (Epi-white) Thraugh
Lens :  FUJINOM YRF43LMD
ExposureTime:
O Auko
(®) Manual

File Mame:

Tris Tray Position

F2.5 z

Clase

Set the exposure time.
Enter a file name.

Click the Start button.

o &~ W N

5.12.3 Method Setting

Put the appropriate tray and calibration plate in the instrument.

Method Setting is used to set the content displayed on the Method/Tray position screen.

i Method Setting,

Method List

Narme Light Filker Tris &
[cve (ReB)] B slue EpireE) @ =50 Foss
[cy2] B3 Blus (Epi-Blus) @ 5o Foss
[Cy3 (REEN] B sreen Epikao) @ srsorz0 Fo.Gs
[cv3] B Green (EpiGreeny  |@ s7sDFz0 Fo.es
[Cy5 (REBI] Il Red (Epi-RaE) @ rso F0.85
[cws] I red (EpiRed) @ rero RS
[DAPI] W v epiiny @ F2.&
[Digitization Epi-ilumination] [ white (Epi-whits) | (O Through  F2.5
[Digitization Trans-llumination] [0 white (Trans-white) | () Through F2.5 b

To delete a method, select the method to be deleted and click Delete.

Note: Only user-defined methods can be deleted.

¢ To edit a method, select the method to be edited and click Edit.
Note: Only user-defined methods can be edited.

¢ To add a method, click Add.
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5.12 Option menu
5.12.3 Method Setting

Result: The following dialog is displayed.

Method Setting

Hame: | TomsMethod |

Light: |. Blue (Epi-Blue) v|

Filter: |. R7a0 v|

Iris: |FD.ES V|

1 Enter a Name for the method.
2 Select appropriate settings for Light, Filter and Iris.

3 Click OK.

Note: Optical characteristics can be corrected using the Flat Frame Calibration function for the
added Method. See Section 5.12.2 Flat Frame Calibration, on page 105.

5.13 Help menu

User Manual
Opens the ImageQuant LAS 4000 User Manual in the default pdf browser.

Getting Started
Opens the Getting Started with ImageQuant LAS 4000 manual in the default pdf browser.

End-User License Agreement
Opens the End-User License Agreement in the default pdf browser.

Sensitivity/Resolution
The figure showing the relation between sensitivity and resolution is displayed. Click to close the window.

SensiivityRosolution
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5.13 Help menu

About ImageQuant LAS 4000 Control Software

The version information of Image Reader is displayed.

Click to close the window.

ImageQuant™ LASV 4000

@ imagination at work VerSion 11
e Build 1.1.0.17

O TR Instrurment S 8675001
%em RO Ry

* i OMPANY - ALL RIGHTS RESEAVED
chnical Support - http: |, gelifesciences. comfcontack
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6 Installing ImageQuant LAS 4000 Control Software

6 Installing ImageQuant LAS 4000 Control
Software

Administrator priveleges required

All tasks related to software installation or uninstallation require a computer account with administrator
priveleges.

6.1 Installation sequence

Software installation is performed in the following sequence:
1 Install the USB contol driver

2 Install the USB function driver

3 Install the ImageQuant LAS 4000 Control Software

6.2 Install ImageQuant LAS 4000 Control Software under
Windows XP

Before you begin

Log in using a Windows account with administrator privileges.

Install the USB Control Driver (Windows XP)

Step Action

1 Disconnect ImageQuant LAS 4000 from the computer.

2 Open the control panel and select Printers and Other Hardware.

3 Click Add Hardware.

4 Click the Next button in the Add hardware wizard.

5 Select Yes, I have already connected the hardware and click the Next button.
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6 Installing ImageQuant LAS 4000 Control Software
6.2 Install ImageQuant LAS 4000 Control Software under Windows XP

Step Action

6 Select Add a new hardware device and click the Next button.

Add Handware Wizard

The following hardware is already installed on your computer .

From the list below, select an installed hardware device, then olick Newt to check
2 on troubleshool a problem you might be having

To add hardware not shown in the list, click “Add a new hardware device."

Installed hardware:

& USB Root Hub

& UISB Mass Storage Device
& Generic USE Hub
&2 USB Composite De

7 Select Install the hardware that | manually select from a list [Advanced] and click the
Next button.
8 Select Show All Devices and click the Next button.
T T ——————
I:am:mhamewei -
i
prasc .
9 Click the Have Disk button in the Add hardware wizard.
10 Insert the ImageQuant LAS 4000 Control Software CD and click the Browse button.
11 Select to install the driver from the ImageQuant LAS 4000 Control Software CD.
Lock i |12 bnageluant LAS 4000(0| 4 OFim

My Flacent
[Isp—h

@ .
Detkicp 35nm<ngp‘ﬂlﬂﬁ'.{'|||?|.'|
3 Shaed Documents
1) My Dotimends
S My Mistrant Placas

My Docurires
8
My Corrpudes
Fie gamec nl * [ ]
My Retreck  Fien of g Concel |
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Step

6 Installing ImageQuant LAS 4000 Control Software
6.2 Install ImageQuant LAS 4000 Control Software under Windows XP

Action

12

13

14
15
16
17

18

Open the USB Control folder.

Lovh i | 1) bnogeluant LAS 4000 (0.1 & OF=m
(e
F LSS Furctony
My Racent
Dexumords
Detkizo
My Documents
My Compndes
"j Fie gane “inl ¥ 2o ]
ytided Pt [ Corcet ]

Select the DevMnag.inf file and click the Open button.

Lok jn; | (3 USB Control Yot E
Flename  |Deuting ¥ (o=
Files of type:

Click the OK button in the Install from disk dialog.
Click the Next button in the Add hardware wizard.
Click the Next button again.

Click the Continue Anyway button in the Hardware Installation dialog.

Hardware Installation

] The software pou are installing for this hardware:
e
FLAJLAS LISB Device Managment Diiver

has not paszed Windows Loge testing to verify it compatibility

wiith wéindaws ¥P. (Tell me whu this testing is impartant.|

Continuing your i ion of this sof may impair
or destabilize the comect operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

[ Continue Arpway | [ STOP Installation |

Click the Finish button to complete the driver installation.
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6.2 Install ImageQuant LAS 4000 Control Software under Windows XP

Install the USB function driver (Windows XP)

Step

Action

1

Connect the computer and the ImageQuant LAS 4000 with a USB cable and turn ON the
power switch of ImageQuant LAS 4000. The scanner is automatically detected by the
computer.

In the Found New Hardware Wizard dialog, choose No, not this time.

Found New Hardware Wizard

‘Welcome to the Found New
Hardware Wizard

Click Next to continue.

Click the Next button in the Found New Hardware Wizard dialog.
Insert the installation CD.

Select Install the software automatically (Recommended).

Click the Next button in the Found New Hardware Wizard dialog.

Click the Finish button to complete the installation.

Install ImageQuant LAS 4000 Control Software

(Windows XP)
Step

Action

1
2

112

Insert the ImageQuant LAS 4000 Control Software CD.
Locate and double-click the file ImageQuant LAS 4000.msi.
In the ImageQuant LAS 4000 - InstallShield Wizard, click the Next button.

Read the license text. If the license agreement is not acceptable please contact a GE
Healthcare representative, see back cover of this manual for contact information.

Select I accept the terms in the license agreement and click the Next button.
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6.2 Install ImageQuant LAS 4000 Control Software under Windows XP

Step Action
5 Select destination folder in the dialog:
i'-.g ImageQuant LAS 4000 - InstallShield Wizard (%]
Destination Folder ‘ 115
Click Mext to install to this folder, or click Change to install to a different folder. o I
G Install Imagecyuant LAS 4000 to:
C:iProgram Files) Change..

¢ Click the Next button to install the software at the default folder C:\Program Files.
e Click the Change button to install to a different folder.

6 Click the Install button in the installation dialog.
7 Click the Finish button.
8 Start the ImageQuant LAS 4000 Control Software. This will ensure that necessary folders

and files are created.

6.3 Install ImageQuant LAS 4000 Control Software under
Windows Vista

Before you begin
Log in using a Windows account with administrator privileges.

Install the USB Control Driver (Windows Vista)

Note: During software installations, you may be asked to confirm your actions in a dialog with
the text Windows needs your permission to continue. Enter an administrator password,
if prompted, then click Continue to proceed with the installation.

Step Action

1 Disconnect ImageQuant LAS 4000 Control Software from the computer.
2 Open the control panel and click Classic View in the upper left corner.

3 Open Add Hardware.
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Step Action
4 In the Add Hardware dialog, click the Next button.
5 Select Install the hardware that | manually select from a list (Advanced) and click the
Next button.
6 Select Show All Devices and click the Next button.
yoimm
Pt i
7 Click the Have Disk button.
8 Insert the ImageQuant LAS 4000 Control Software CD and click the Browse button.
9 Select to install the driver from the ImageQuant LAS 4000 Control Software CD.

*‘i Locate File

Logk in: | &% DVD/CD-RW Diive [D:] ImageQuant LAS 4U[H €] & S

2| Recent ltems e
I — te modif... | Location
= Bl Desktop
7 o Netwark
Recent Places ‘H admin
Public
! 8 Computer
= Floppy Disk Drive (4]
Deckt
" £, Local Disk (T)
T" Windows
¥ u"
admin &
o STORE M GO [E:
I
LY
Computer
| Wi
]
Network
File narme: “inf -
Files of type; Setup Information [* inf]

==
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Step

6 Installing ImageQuant LAS 4000 Control Software
6.3 Install ImageQuant LAS 4000 Control Software under Windows Vista

Action

10

11

12
13
14
15

16

Select the USB Control folder and click Open.

# LocateFile ==
Lookir: 4% DVD/CD-Rw Diive (D) Imagefuant LG 400 + & (T 2 [Ev
7 Name Size Type Date modif.. Location
e Files Currently on the Dise (2) -
Recent Places
| USE Centrel
[ ,El File Folder
bl
Deskt
sseR USE Function
; i L File Folder
Wi o
2dmin
L™
Computer
[ ™
-
Network
File name: “inf hd
Files of type: Setup Ifommation [ rf)

Select the file DevMng and click the Open button.

 Locate File ]

Logkmn: | UEB Contl - @y

- Bl
Recent Places

Deiktop

Computer
K
L.

-

Click the OK button in the dialog Install from disk.

Click the Next button in the wizard Add hardware.

Click the Next button once again.

The following warning is displayed. Proceed by cliking Install this driver software anyway.

+ Install this driver software anyway
 install driver software cbtained from your manulfactuter's webtite o
igned software from cther sources may harm your computes or stest

Click the Finish button in the Add Hardware wizard to complete the installation.
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Install the USB function driver (Windows Vista)

Note: During software installations, you may be asked to confirm your actions in a dialog with
the text Windows needs your permission to continue. Enter an administrator password,
if prompted, then click Continue to proceed with the installation.

Step Action

1 Connect the computer and the ImageQuant LAS 4000 with a USB cable and turn ON the

power switch of ImageQuant LAS 4000.
Result: The scanner will automatically be detected by the computer and the Plug and
Play function in Windows Vista starts.

2 In the Found New Hardware dialog, select Locate and install driver software (recom-

mended).

3 Insert the ImageQuant LAS 4000 Control Software CD and click the Next button in the

Found New Hardware dialog.

4 Select Install this driver software anyway.

4t Windows Secarity ==]
‘%" Windews can't verify the publisher af this driver software
5 A successful installation message appears. Click the Close button.

Install ImageQuant LAS 4000 Control Software
(Windows Vista)

116

Note:

Step

During software installations, you may be asked to confirm your actions in a dialog with
the text Windows needs your permission to continue. Enter an administrator password,
if prompted, then click Continue to proceed with the installation.

Action

Insert the ImageQuant LAS 4000 Control Software CD.
Locate and double-click the file ImageQuant LAS 4000.msi.
In the ImageQuant LAS 4000 - InstallShield Wizard dialog, click the Next button.

Read the license text. If the license agreement is not acceptable, please contact a GE
Healthcare representative. See the back cover of this manual for contact information.

Select I accept the terms in the license agreement and click the Next button.
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6.3 Install ImageQuant LAS 4000 Control Software under Windows Vista

Step Action
5 Select destination folder in the dialog:
15T ImageQuant LAS 4000 - Inatallshuekd Wizerd =
(Chek Nt bo inedtiall 1 Phis Folder, o click Change to install o a different folder. ‘ -
G g P
[T T
¢ Click the Next button to install the software at the default folder C:\Program Files.
e Click the Change button to install to a different folder.
6 Click the Install button.
7 If User Account Control (UAC) is enabled in Windows Vista, a dialog displays the message
An unidentified program wants access to your computer. Click Allow.
8 Click the Finish button.
The installation of ImageQuant LAS 4000 Control Software is now completed.
9 Start the ImageQuant LAS 4000 Control Software. This will ensure that necessary folders

and files are created.
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7 Uninstalling and upgrading
ImageQuant LAS 4000 Control Software

Before you begin
Log in using a Windows account with administrator privileges.

Uninstalling ImageQuant LAS 4000 Control
Software under Windows XP

Step Action
1 Open the control panel and select Add or Remove Programs.
2 Select ImageQuant LAS 4000 and click the Remove button.
8 Add or Remove Programs
B | Comenty mtales programs and st Shomupdates  Sorkby:
CE::%i;’ %% ImageQuant LAS 4000 Siz -~
Programs Used y
Add New @ Inkel(R) Graphics Media Acceleratar Driver
Programs . Intel(R) Management Engine Interface Sze  0.0IMB
B8 Intel(R) Network Connections 13.1,33.0 Size 4.89MB
AddjRemove | Intel® Active Management Technology Size 0.16MB
Cnﬂn:';g:‘g;ts 2] 38va(Th) 6 Lipdate 7 See 171,00MB
#3 Microsoft NET Framework 1.1
@ 5 Microsoft NET Framework 1.1 Hotfix (KB326356)
Set Program @ Micrasoft NET Framework 2.0 Service Pack 2 Size  185.00MB
AE‘;Z;T 45 MET Framework Presp Installed On - 6/11/2009
5 keasaaar Installed On 6/11/2003
§5) Dr. wiatson Installed On  6§11/2009
ﬁ MET Framework CRT Installed On 6/11/2003
§5) MET Framework CA Instaled On  6/11/2003
3 MET Framenark CLR Installed On 6/11/2003
ﬁ MET Framework WinForms Installed On - 6/11/2009 3
Note: Correction files created during calibration are required by the ImageQuant LAS 4000

Control Software. They are not deleted during the uninstallation, and remain in the Data
folder of ImageQuant LAS 4000 Control Software folder.

Uninstalling ImageQuant LAS 4000 Control
Software under Windows Vista

Step Action

1 Open the control panel and Select Uninstall a program under Programs.
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Step Action

2 Select ImageQuant LAS 4000 and then click Uninstall.

mra -

g{‘_ O

3 Confirm the uninstallation by clicking Yes when prompted.

4 If User Account Control (UAC) is enabled in Windows Vista, a dialog displays the message
An unidentified program wants access to your computer. Click Allow.

Upgrading ImageQuant LAS 4000 Control

Software
Step Action
1 Uninstall the current version of ImageQuant LAS 4000 Control Software.
2 Install the new version of ImageQuant LAS 4000 Control Software.
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8 After-sales service

8 After-sales service

8.1 Warranty

1 The warranty period will expire after 1 year from the date the system was delivered.

2 GE Healthcare will make repairs free of charge for failures during the warranty period, provided
that normal usage conditions and the instructions given in this manual, etc., are followed.

3 Repairs of the following failures will be charged for even if the warranty period has not yet expired.

* Problems caused by incorrect usage and/or by any products other than those authorized by GE
Healthcare and/or problems caused by other equipment.

* Problems and/or damage due to moving, transport and/or falling.

8.2 Repairs

1 Before asking for repairs, refer to the troubleshooting section in Getting Started with ImageQuant
LAS 4000.

2 Ifthe problem persists, fill in the service report fax sheet at the end of this manual and contact your
GE Healthcare representative.

3 The guaranteed repair service period of this product is 5 years from the termination of sales.
Thereafter, repair service may not be provided if repair parts become out of stock.
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A Appendix

Appendix A Appendix

A.1 Glossary

CCD Calibration

Electric charges are accumulated on the CCD evenifitis not exposed to light. The accumulated electric
charge is called a dark current noise. The process for eliminating the noise component is performed
by CCD calibration. The image constituted by the dark current noise is called CCD calibration data. An
image that is constituted by only the electric charges accumulated during exposure can be created
by subtracting the CCD calibration data from the exposed image.

Flat Frame

In an exposure system using a 2D sensor such as a CCD, unevenness due to the lens or lighting system
appears on the image. By correcting the unevenness, an object that radiates light at the same brightness
is represented evenly in any section of an exposure area. A correction file for correcting unevenness
is called a flat frame. Under the same conditions (tray position, iris, fluorescent filter, light source, and
tray) as when exposing an object sample, a flat frame records the image in a uniform fluorescent plate
(fluorescent mode) or white plate (digitize mode).
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A.1 Glossary

Conceptual diagram of CCD calibration and flat frame

Virtual profile in which
light is supposed to be
uniformly emitted from
the whole image

Sample image

Electrical noise
component

Center

CCD Calibration Data

a an S T Y
1
Center
FlatFrame
'Optical unevenness' |
Center

A.2 Quick-reference functions

Function Function name Set item

Raw image
State of image that
. is not corrected
Center

y

|Z Raw image—CCD Calibration Data

Removal of noise
. component
Center

\

DX (Raw image—CCD Calibration Data).”
FlatFrame

Limb darkening due to
optical characteristics

Center

Exposing for a fixed exposure | Exposure Type Precision
time

Exposing consecutively Exposure Type Increment
Exposing repeatedly Exposure Type Repetition
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A.2 Quick-reference functions

Function Function name Set item

Determining exposure time Exposure Time Auto
automatically

Entering and determining ex- = Exposure Time Manual
posure time
Determining a desired expo- | Exposure Type Program

sure time and expose.

Setting the exposuretime and | Exposure Type Program settings
the exposure intervals.

Sensitivity/Resolution High Resolution

Standard

High

Setting sensitivity and resolu- Super

tion Ultra

High Binning

Super Binning

Ultra Binning
Exposing a chemilumines- Add Digitization Image On
cence and a digitized (white
epi-illuminated) image by sin-
gle-click operation
Method Chemiluminescence

Fluorescence:EtBr

Fluorescence:SYBR Green

Fluorescence:GFP

Fluorescence:Cy3

Selecting detection method
Fluorescence:Cy5

Fluorescence:Dy781

Fluorescence:DAPI

Digitization:DIA

Digitization:EPI

Method/Tray position Select the tray position from 1

Changing tray position to 4.
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A.2 Quick-reference functions
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Function

Adjusting focus

Starting exposure

Inverting image data

Function name

Focusing

Start

Edit:Preference

Digitization Epi-illumination tab
Invert pixel data

Set item

Fine-adjust the light using
Brightness and the focus using
Adjust.

Yes

Saving a file in TIFF format

Edit:Preference
File Format tab

Select a 16-bit Linear TIFF for-
mat

Saving window image directly

Edit:Preference
File Format tab

Select an 8-bit Color TIFF for-
mat

Changing the temperature Edit:Preference Set the temperature
setting of CCD CCD Cooling tab
Changing the folder of file Edit:Preference Specify the folder where a file
saving Root Folder tab is saved
, o o Edit:Preference Enter size in percent
Fine-adjusting the print size . )
Print Adjust tab

Displaying saturated data in
red

View:Paint saturated data Red

Select and check

Displaying image in Negative
Gray

Displaying image in Positive
Gray

View:Negative Gray

View:Positive Gray

Select and check

Select and check

Creating CCD Calibration file

Option:CCD Calibration

Select and set conditions for
Start

Creating Flat Frame

Option:Flat Frame Calibration

Select and set conditions for
Start

Checking software versionin- | Help:About ImageQuant LAS Select
formation 4000 Control Software
Checking therelation between | Help:Sensitivity/Resolution Select

sensitivity and resolution
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A.3 Detection Reagents and corresponding settings

Note:

Classification

Chemiluminescence

A Appendix

A.3 Detection Reagents and corresponding settings

The RGB module may be used instead of the separate red, green and blue Epi lights.

ImageQuant LAS 4000 setting

Reagentnome —— — — —  — — — —
Method Light Filter

ECL Chemiluminescence none Through 0.85
ECL Plus Chemiluminescence none Through 0.85
Lumi-Light Plus | Chemiluminescence none Through 0.85
Renaissance Chemiluminescence none Through 0.85
Super Signal Chemiluminescence none Through 0.85
Bright-Star Chemiluminescence none Through 0.85
CDP-Star Chemiluminescence none Through 0.85
CSPD Chemiluminescence none Through 0.85
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A.3 Detection Reagents and corresponding settings

Classification

Fluorescence dye

126

Reagent name

ImageQuant LAS 4000 setting

Method Filter Iris

EtBr Fluorescence:EtBr UV (312nm 605DF40 2.8
Trans)

Cy2 Fluorescence:SYBR Green | Blue (460nm Y515-Di 0.85
Epi)

SYBR Green | Fluorescence:SYBRGreen | Blue (460nm Y515-Di 0.85
Epi)

SYBR Green |l Fluorescence:SYBR Green | Blue (460nm Y515-Di 0.85
Epi)

SYBR Gold Fluorescence:SYBR Green | Blue (460nm Y515-Di 0.85
Epi)

SYPRO Ruby Fluorescence:SYBR Green | Blue (460nm Y515-Di 0.85
Epi)

SYPRO Orange | Fluorescence:SYBR Green | Blue (460nm Y515-Di 0.85
Epi)

SYPRO tanger- = Fluorescence:SYBRGreen | Blue (460nm Y515-Di 0.85

ine Epi)

FITC Fluorescence:SYBR Green | Blue (460nm Y515-Di 0.85
Epi)

FAM Fluorescence:SYBR Green | Blue (460nm Y515-Di 0.85
Epi)

EGFP Fluorescence:GFP Blue (460nm 510DF10 0.85
Epi)

ECFP Fluorescence:GFP Blue (460nm 510DF10 0.85
Epi)

RITC Fluorescence:Cy3 Green (520nm | 575DF20 0.85
Epi)

Cy3 Fluorescence:Cy3 Green (520nm | 575DF20 0.85
Epi)

Cy5 Fluorescence:Cy5 Red (630nm R670 0.85
Epi)

Alexa 633 Fluorescence:Cy5 Red (630nm R670 0.85
Epi)

Alexa 660 Fluorescence:Cy5 Red (630nm R670 0.85
Epi)
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Classification

Reagentname —  — — — — — — — +— —
Method Light Filter

A Appendix

A.3 Detection Reagents and corresponding settings

ImageQuant LAS 4000 setting

[§13

Alexa 680 Fluorescence:Cy5 Red (630nm R670 0.85
Epi)
Q-dot Fluorescence:DAPI UV (365nm Epi) | L4l 2.8
Dy781 Fluorescence:R Infrared IR785 0.85
(710nm Epi)
Alexa 680 Fluorescence:IR Infrared IR785 0.85
(710nm Epi)
Alexa 700 Fluorescence:IR Infrared IR785 0.85
(710nm Epi)
Attophos?! Fluorescence:SYBRGreen | Blue (460nm Y515-Di 0.85
Fluorescence dye (Chemi- Epil
fluorescence) ECL Plus Fluorescence:SYBRGreen | Blue (460nm | Y515-Di 0.85
Epi)
Silver stain Digitization:Trans White (Trans) Through 2.8
CBB stain Digitization:Trans White (Trans) Through 2.8
Digitization
X-ray film Digitization:Trans White (Trans) Through 2.8
NBT/BCIP Digitization:Epi White (Epi) Through 2.8

1 Attophos cannot be used for detecting nucleic acid on a nylon membrane.

Note:

With regard to patents owned by third parties related to, among other things, sample
preparation, we recommend that you consult with a lawyer or patent attorney about
obtaining a license from the third parties.

A.4 Main specifications

CCcD

3200 000 pixels (Fujifilm super CCD)

Cooling temperature

-25°C

Number of gradations

Recorded image:

Focusing:

16 bit
8 bit

Exposure time

1/100 seconds to 2 hours

(Images can be continuously exposed for up to 30 hours using ImageQuant LAS 4000

Control Software.)
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Lens High-sensitivity lens F0.85 43 mm
Wide view lens F1.8 24 mm

Shading correction Software system

Maximum sample size 250 x 250 mm with F1.8 24 mm lens
210 x 140 mm with F0.85 43 mm lens

Dynamic range 4 orders of magnitude

Maximum image size 12.6 MB

Light source Epi (class 1 light source)
Blue Epi light 2460 nm
Green Epi light :520 nm
Red Epi light 1630 nm

RGB Module (Epi light) : 460 nm, 520 nm or 630 nm
NIR Epi light :710 nm

Epi and Trans (class 1M light source)

UV Epi light 1365 Nm

UV transilluminator 1312 nm

Size 1322 %313 %87 mm
UV transmitted filter size 200 x 200 mm

White transmitted light table  : White LED
Size :322%x313x87 mm

External dimensions
Camerahead :224x161x 252 mm (W/H/D)

IDX 510 % 730 x 480 mm (W/H/D)
Weight
Camera head 3.4 kg
IDX : 49 kg (not including the light source, lens, and tray)

High-sensitivity lens  : 4.5 kg
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A.4 Main specifications

Power requirements

Input voltage :100-240 V~
Voltage variation +/-10%
Phase : Single phase
Power frequency :50/60 Hz

Rated input current  :3.0-1.5A

AC power cable

Use the cable supplied with the instrument.

Specifications of cables required for the use of ImageQuant LAS 4000

Voltage

Plug/connector

Cable

Power supply cord length
Voltage

Plug/connector

Cable

Power supply cord length

:100-120V

:125VAC, 13 A

:SJT3 x 16AWG 60°C
:Maximum 3 m

:200-240V

1250V AC, 10A

: CENELEC OC 3 x 1.0 mm? 70°C

:Maximum 3 m
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Installation conditions Placement conditions

Free space required around ImageQuant LAS 4000

Secure space for maintenance work as follows:

Front :600 mm
Right :600 mm
Left 1600 mm
Rear  :200 mm

Top : 1000 mm

Table strength

The allowable load must be 981 N/m? (100kg/m?) or greater.

Other conditions

1 Decide on an installation location taking into consideration the work flow and

ancillary facilities to be used.

2 Required construction work and electricity/air conditioning work must be complet-

ed in advance.

3 Itis not desirable to have a heat source on the IDX right side face where there is
an air intake fan even if the environmental requirements have been met.

4 Do notinstall the equipment near a window to avoid direct sunlight. Attach a blind

to nearby windows.

5 Do not place objects near the power outlet so that you can disconnect the power
cable from the outlet in case of emergency.

Floor oscillation conditions

(1) Operating time Oscillation
Impact
(2) Non-operating time  Oscillation

Impact

130

:0.03G (5 to 60 H2)
:1G

:0.4G (5to 60 Hz)
:2G
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A.4 Main specifications

Environmental conditions

Operating temperature/humidity conditions

Temperature :15°Cto 28°C (with temperature fluctuation below 10°C
per hour or lower)

Humidity 30 % to 70 % RH  (no dew condensation)

When the above conditions cannot be satisfied, modify the facilities accordingly.

Transportation/storage conditions

Temperature  :-25°Cto 70°C

Humidity 5 % to 100 % RH (no dew condensation)

Installation location conditions
1 Do notinstall the equipment in an area where the temperature varies widely.
Do not install the equipment near a source of heat.
Do not install the equipment in an area where it may get wet or flooded.
Do not install the equipment in an area where it may be exposed to corrosive gas.

Do not install the equipment in a dusty area.

o LB~ WN

Do not install the equipment in an area constantly or excessively exposed to os-
cillations or impacts.

7 Do not install the equipment in an area exposed to direct sunlight.

Operation site :Indoors

Maximum operating altitude : 2000 m or lower

Overvoltage category category Il : Transient overvoltage

Rated pollution applied : Pollution Degree 2
Analysis unit interface USB 2.0

Do not connect the ImageQuant LAS 4000 USB connector to a computer not certified
with UL60950-1 (UL listed) and IEC60950-1.

Others

Noise : 70 dB (A) or lower
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A.5 Minimum computer requirements

132

Operating system | Windows™ XP™ SP3
or
Windows Vista™ Business SP1 (32-bit)
Memory 1 GB or more
Processor Intel Core 2 Duo processor
HD 80 GB or more
USB port version usB 2.0
Optical drives DVD-ROM

Monitor resolution

1280 x 1024 pixels or more
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A.6 Service report fax sheet

To:

SERVICE REPORT FAX SHEET

Customer information

1) Company name

2) Person in charge

3) TEL

4) FAX

5) E-mail

6) Serial No.

ImageQuant LAS 4000 system information

e Camera head
e Others

7) Analyzing unit type

e Operating environment

e Machine model

Windows

8) Usage frequency

9) Trouble occurrence frequency

10) Error code and failure description
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